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Notations.

Roman

a semi-major axis m
a speed of sound m/s
a dimension of spin vane m
b dimension of spin vane m
Cp drag force coefficient -
C, rolling moment coefficient -
C, lift force coefficient -
Cn pitching moment coefficient -
C, yawing moment coefficient -
Cs side force coefficient -
Cx axial force coefficient -
C, normal force coefficient » -
d aerodynamic reference length m
at simulation step S
D drag force N
D, nominal diameter m
e eccentricity -
e elipticity -
Fgo gravitational force N
9o reference gravitational acceleration at surface m/s?
g _load occurring dimensionless deceleration (deceleration/g) R
h height (geometric altitude) m
hpg initial altitude for horizontal gust m
i inclination rad
I inertia tensor kg m?
L roll moment Nm
L lift force N
Liser riser-line length m
L, suspension-line length m
L/D lift-to-drag ratio -
m mass kg
m, added mass kg
M ‘pitch moment Nm
M Mach number -
M., swivel moment Nm
Np number of parachutes -
ng, number of spin vanes -
N yaw moment Nm
p atmospheric pressure N/m?
p angular roll rate w.r.t. the |-frame rad/s
Pret reference pressure _ N/m?2

q . angular pitch rate w.r.t. the I-frame rad/s
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Qayn dynamic pressure N/m?
r angular yaw rate w.r.t. the |-frame rad/s
r distance to the Centre of Mass of the central body m
lsy mean local radius descent module for spin vanes m -
R, radius at equator m
S side force N
) aerodynamic reference area m?
S, nominal reference area m?
t time s
thg thickness of horizontal gust m
Tin kinetic temperature K
u cartesian velocity in X-direction m/s
v cartesian velocity in Y-direction m/s
14 relative flow velocity m/s
Vhg,max maximum velocity for horizontal gust m/s
Vs steady state wind velocity m/s
Viss.max maximum steady state wind velocity m/s
Vss.s steady state wind velocity at surface m/s
w cartesian velocity in Z-direction m/s
X cartesian x-position m
Xant X-coordinate attachment m
Xgy X-coordinate spin vane m
y cartesian y-position m
b4 cartesian z-position m
Greek

o angle of attack rad
or total angle of attack rad
a time derivative of a rad/s
B angle of sideslip rad
B time derivative of B rad/s
Y flight-path angle rad
) planetocentric latitude rad
Mgy efficiency (scale) factor of spin vanes

0 pitch angle rad
0 true anomaly rad
0, attitude angle spin vane rad
A longitude rad
m gravitation parameter m3/s2
p atmospheric density kg/m®
o bank angle rad
T planetocentric longitude rad
) roll angle rad
X heading rad

oot oL AL
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1 yaw angle rad
o argument of pericentre rad
Q longitude of the ascending node rad
Indices

a airspeed based

g groundspeed based

o] parachute

r (re-)entry vehicle

sv spin vane

X X-direction
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1. Introduction.

This user manual describes the re-entry simulation software package START (an acronym for
Simulation Tool for Atmospheric Re-entry Trajectories). The development of START Version -
1.0 began as a part of a thesis study for Aerospace Engineer of Delft University of Technology,
Faculty of Aerospace Engineering. The thesis study was performed at ESTEC, Noordwijk (The
Netherlands), and covered a period of 10 months (January - October 1991). This development
has been extensively described by Mooij (1991a and 1991c). The program was used to do a
first mission analysis of the ESA Huygens Probe (Mooij, 1991b).

START Version 2.0 was the outcome of a seven months part-time activity for the Huygens
Project Team at ESTEC, and started in January 1992 (Mooij, 1992). An additional contract for
ESTEC, dealing with the implementation of the deorbit-burn manoeuvre, finally led to the current
version of START (Mooij, 1993a).

This manual will concentrate on how to use the software; no technical description of re-entry
flight dynamics nor a discussion on how START was developed, is given. For this, the interest-
ed reader is referred to the above mentioned references. Before discussing the capabilities of
START, we will give a short overview of START and some general remarks on the User Inter-
face (Ul). A full documented listing of the program is published as an Appendix to this user
manual (Mooij, 1993b). However, this document is not available to the general public.




Organization: TUD/LR/A2R ) Date: July 1993
Document code: LR-726 Page: 2

2. General description of START.

2.1. Overview of features.

START can be defined to be a 6-dof open-loop re-entry trajectory simulation tool. Open-loop
means here, that there are no guidance and control capabilities. The equations of motion, which
can be divided into equations of translational motion (position and velocity) and equations of
rotational motion (attitude and angular motion), are based on the following state variables: r, T
and & for the position; V, y and x, for the velocity; p, and r (the rotational rate of the body w.r.t.
to the inertial planetocentric frame) for the angular motion; and a (angle of attack), p (angle of
sideslip) and o (bank angle) for the attitude of the re-entry vehicle w.r.t. the oncoming flow. As
an alternative definition of the attitude, the so-called quaternions have been implemented.

As is indicated in Fig. 2.1, the actual flight dynamics code, the core of the program, is embedd-
ed in a Ul. It provides the user with a friendly tool to edit all the input data necessary for the
trajectory analysis and to start the simulation itself. In other words, all possible actions can only
be activated by means of this Ul.

The input data can be divided into four blocks, in Fig. 2.1 indicated with trapezoids. The first
block is related with the re-entry vehicle. A vehicle can be described as a number of mass ele-
ments, each with its own mass, CoM and inertia tensor. This way of entering the vehicle en-
ables a user to 'build’ a re-entry vehicle on basis of fundamental geometrical shapes with readi-
ly available inertia tensors. The global inertia tensor will be computed during the simulation.
Besides, this concept of mass elements can also be used for configuration changes by just
deleting one (or more) of the mass elements.

A major part of the vehicle data consists of the aerodynamic database. Each of the (six) force
and moment coefficients can be written as a Taylor series, as a function of a number of
independent variables, for instance:

CF= CFO + CFXI.X1 + Csz'xz + ...+ CFX1'X2'X1 'X2 + ...

The variables Xi are called derivation variables (e.g., «, B, one of the three angular rates); the
order of derivation can be 0, 1 or 2. Besides, each of the coefficients CF.. can be entered as
a table (max. 10x10), as a function of 0, 1 or 2 table variables (e.g., a., B, Qo M). This way
of entering aerodynamic data is very flexible. And, by storing the data in a separate file, the
aerodynamic data can be updated after each configuration change, by simply reading in an
aerodynamic database file. The aerodynamic forces and moments consist of the drag, side and
lift forces D, S, and L, and the rolling, pitching and yawing moments L, M and N, respectively.




Date: July 1993

Organization: TUD/LR/A2R
Document code: LR-726

Page: 3

VI¥ILID dO1S
S3ONVYIT01
3LvY ONIT 1ndLRO

SITEVIVA 30NLLLY
4009/ 400¢
NOILVINAIS 18V1S
NOLLVZITVLLINI

NNIN NIV OL N¥NL3Y

NOILYINAIS &0LS

anunng

NYNG 1184030

S39NVHO NOILVYNOIINGD
3SVI13¥ ANHOVYVd
ONI433¥ AINHOVYVd
IN3NA0Td30 AUNHOVAVd

NOLLYINAIS GOHL3N NOLLVHOLNI
SILIOTIA YVINONY
NOLON 10 3anLILLY
NOUVINI 33dS
NOLLISOd
SININOW ONV S3JN04 TYNNALX3
NOUOW 30 SNOILYND3
SHMVNAQ MY |
SNOUYHI TV
ONW
300N 3HASONLY
TI00N ALAVYO
AG08 VHIND
IIIIIIIIIIII A4 ____1

NILSAS NOISINGOYd

SIN3A3 NOISSIN

SININON ONV S30H0J TVNYILX3

SW3ISAS I1NHIVYVd
SJINVNAGOYIV
AYLIN03D 3ONFYISI
HOSNIL VILAINI

N NOUVION

SSVN

JOVA4IINI 43SN

VI¥ILYI d01S

ON

SNOILYY3dO NOISINdO¥d

S3ONVHO NOLLYYNIIINGD
SNOLVY3dO 3LNHIVYYd
VIS WILIN

Fig. 2.1 - Schematic layout of START.
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As a parachute model, a 3D, 6-dof model has been implemented. Both the parachute and the
re-entry vehicle are thought to be rigid bodies (no mass points), connected by a rigid bar. This
rigid-bar connection prevents the two bodies to rotate w.r.t. each other. However, the two
bodies can spin w.r.t. each other, along this hypothetical bar, because a (non-ideal) swivel has .
been implemented in the connection between parachute and re-entry vehicle. Non-ideal means
here, that the swivel causes a friction moment that counteracts the spinning motion. The air in
and under the parachute is taken into account as added mass. The shape of the canopy is
defined to be a hemisphere. The model may also include reefing (i.e., step-wise opening) of the
parachute. Three parachute systems can be defined.

To create additional external moments, a simplified spin-vane model has been implemented.
Each vane is considered to be a rectangular flat plate. The lift and drag contribution for one
vane is computed, based on flat-plate theory. These forces result in a rolling moment that drives
the re-entry vehicle. The contribution of all the vanes is taken into account by multiplying the
computed rolling moment by the number of vanes. This implies, that the flow direction for each
vane is assumed to be identical, so no transverse winds can be studied, for instance.

The definition of the propulsion system is currently restricted to an engine, which can only be
used for a deorbit-burn manoeuvre. Engine properties are given by the (constant) thrust and
specific impulse. The thrust force is supposed to act on the CoM of the spacecraft.

The second block deals with the environment. In the first place, a central body can be selected.
This can either be the Earth, the Moon, Mars or Titan. Depending on the central body is the
choice of the gravity model (central field plus harmonics up to J, and that of the atmospheric
model. For the Earth, there are three available models: US Standard atmosphere 1962 (US62),
US76 and a simple tabulated model based on US76 (up to 90 km) and CIRA86 (above 90 km).
The Martian atmosphere is also tabulated and based on Viking-1 data. For the Titan atmo-
sphere, the tabulated minimum, nominal and maximum Lellouch-Hunten model of October 1987
are used.

A major part of the environmental data consists of the wind database. Presently, the wind model
may exist of a steady-state wind and horizontal wind gusts. The steady-state wind can be
defined as two components, either a zonal and a meridional component, or a modulus and
direction component. The components can be entered in tabular form, being a function of two
independent variables at the most (i.e., the atmospheric pressure, the height and the latitude,
with a maximum of 40 entries per variable). It is also possible to define a zonal component only,
being a (simple) function of the planetary rotation. In addition, the so-called Flasar wind model
has been implemented for Titan. This is an engineering model, defining a zonal steady-state
wind as a function of altitude (atmospheric pressure) and latitude.

A total of 10 horizontal wind gusts can be specified. Main parameters are the initial altitude, the
thickness, the maximum velocity and the direction of each gust. Two shapes have been prede-
fined.

The mission block enables the user to define the mission of the re-entry vehicle. Data corre-
spond to the initial state of the vehicle (for position and velocity, both spherical, cartesian and
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orbital parameters can be specified), parachute deployment, reefing and release, (other) confi-
guration changes and thrust operations. The latter are restricted to the deorbit-burn manoeuvre.
This manoeuvre can be either impulsive (an immediate change in velocity and direction, without
using a thrust force) or based on the operation of the deorbit-burn engine (including fuel-mass
consumption). ‘

The fourth block, simulation, contains data for executing the actual simulation, i.e., the choice
of the integrator (fourth-order fixed-step Runge-Kutta, seventh-order variable-step Runge-Kutta-
Fehlberg, variable-order variable-step Adams-Bashforth, Adams-Moulton, second-, third- and
fourth-order, fixed-step Adams-Bashforth), the maximum integration step size, the output filing
rate for both the quicklook data (information for user during the simulation) and the plot data,
the tolerances of the state variables (used by the variable step size integrators) and the stop
criteria (e.g., t, h, M).

Input data can be stored in a data file and retrieved when necessary. The aerodynamic data,
the parachute systems and the wind model can be stored and retrieved separately.

The actual simulation can be performed in two modes, namely 3 and 6 dof. In the first mode,
the re-entry vehicle is considered to be a mass point and only translations can be analyzed
(little CPU-time is used). In the second mode, the vehicle is thought of as a rigid body and both
translations and rotations can be examined. For the attitude of the body, both aerodynamic
angles (a,p,0) and quaternions can be selected.

Each time step, the equations of motion are integrated to give position and speed (3 dof) and
attitude and angular velocities (6 dof). Mission events can be executed whenever a predefined
flight condition occurs. Computations proceed until a stop criterium is met. In that case, control
is returned to the UL.

2.2. The User Interface.

All features of START can be accessed via a menu-oriented Ul. These features are grouped
together in sub-menus, e.g., loading, editing, and saving input data. A sub-menu can be entered
by simply entering the corresponding number. By selecting a sub-menu choice, we can either
go further down in the menu structure, or return to the previous or main menu. To achieve this,
each sub-menu always has the following two options:

-9- Return to previous menu
-0- Return to main menu

Entering either option [9] or [0}, the user can leave the current sub-menu.

The major part of the menu structure deals with inputting and editing data. Some general marks
apply to this editing. :

In this manual, we use squared brackets [] to indicate that the character(s) between brackets
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must be entered. The Enter-key is indicated by [Enter]. Sometimes, it occurs that we have to
answer a question with yes or no. The keys [y] and [n] are reserved for this. However; also ™
and [N] are valid entries. In this manual, we use the latter notation, but both upper- and lower-
case keys can be used. As we have already seen above, entering a menu option is indicated -
by [1], [2], etc.

In almost all cases, a default value of the input data is shown, which can be accepted, by
pressing the Enter-key, or changed, by typing the required value and then pressing the Enter
key. The default values are indicated by

.. default =

In all cases, the units of the related variables are shown. Angles and angular rates are always
entered in degrees and degrees per second. Radians are not used for input.
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3. Execution of START.

START is primarily an interactive program, which means that with the aid of the extensive Ul
all input data can be modified before simulating. However, the simulations can put a heavy -
computational burden on the system, depending on the type of simulation and the kind of
computer system one is using. For this reason, a so-called batch mode has been included in
START. In this mode, it is possible to overrule the Ul and directly begin a simulation, as will be
explained in the next Section. The interactive mode is discussed in Section 3.2.

3.1. Batch mode.

After execution of START, an introduction screen is shown, giving information about the
program and version number. Besides, the following question is printed:

BATCH datafile name (ENTER for none):

By specifying a file name, the batch mode is invoked. Simply spoken, this means that START
can be executed in a batch job‘. A batch job is a file, containing all commands which are
needed to successfully execute an arbitrary computer program. This batch job is submitted to
a batch queue and executed in the background, with a lower priority than users which are
working interactively. In this way, the computer system is spared and local users are not
bothered by long waiting times. Any output generated by the program is usually written to a
specified .LOG file and can be referenced when the batch job is finished.

In the case of executing START in batch mode, we need to specify some data, for a successful
execution of a simulation. These data are stored in the BATCH datafile. The layout of this file
is as follows:

input-file name {any valid file name}
quicklook-file name {any valid file name}
plot-file name {any valid file name}
simulation mode {1 = 3 dof, 2 = 6 dof}
kinematic attitude variables {1 = (a,B,0), 2 = quaternions}

Nota bene: the user is referred to Chapters 4 and 8 for more specific details on the above data
entries.

As an example, we will define the BATCH datafile BATCH.DAT:

input .dat
output.dat
output .plt
2

1 Executing programs in batch mode is computer dependent and will not be discussed in this manual. For
any specific details the user is referred to the User and Reference Guides of his computer system.
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1
The batch job is started by submitting the following batch file to a batch queue:

$ start?
BATCH.DAT

When START is executed, the following line (i.e., BATCH.DAT) is read when START needs its
firstinput (when the user is asked for a BATCH datafile). When the file does not exist, program
execution is immediately terminated. If the file exists, it is read and checked for any invalid data
entries. If all data are correct, execution is continued, thereby suppressing any output to the
screen. The simulation stops whenever a stop criterium has been met (see Chapter 8).

Warning: any existing output file (output.dat and output.plt in the above example) will be
overwritten!

3.2. Interactive mode: the Main Menu.

The batch mode of START can be ignored if we do not enter a BATCH datafile name. We
begin again with the introduction screen and the question:

BATCH datafile name (ENTER for none):

By pressing [Enter], this screen makes place for the Main Menu as shown below, from which
we can access all features of START.

By entering one of the numbers [1] to [6], we will enter the second layer of the menu structure,
as indicated in Fig. 3.1. In the following Chapters, each of the options of the Main Menu will be
discussed.

2 The command line, as has to be specified on a VAX, has been given here as an example.
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START

LOAD SPUT DATA VEW OIPUT DATA EDIT NPUT DATA SAVE NPUT DATA SMULATION QuT START

T | I T |
| | | | i

LOWER LAYERS OF MENU STRUCTURE

Fig. 3.1 - The Main Menu.
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4. Load input data.

By choosing the option Load input data, the default input filename and a File Menu, as shown
below, appear on the screen. The default file name can be 'INPUT.DAT (program default) or -
the last user-specified hame.

By entering [1], the program will use the defauit input filename, as is shown on the screen. Nota
bene: the program will not check whether the current input dataset has already been saved.
This responsibility is left to the user. Loading a new set of input data will overwrite the current
input data. :

If the input file is not found, an error message is given. After accepting the error message (by
pressing [Enter]), the message disappears and we arrive at the situation as we did when first
entering the File Menu. When the input file is found, the input data are read in. A message on
the screen tells the user that the input data are currently being loaded. If, due to any reason,
an error is encountered during the read process, this process is aborted and an error message
is given. Accepting the error message will result in a return to the File Menu. The input data in
memory may be distorted due to the read error, so therefore the input dataset is automatically
reset to the Apollo configuration as shown in Appendix A. After successfully retrieving the input
data, we return to the Main Menu.

Choosing option 2 enables the user to change the input filename. When changing the filename,
one can also specify the drive and/or a (sub-)directory. Pressing [Enter] will terminate the input.
If no name has been given - a so-called blank filename has been entered - the default name
will be assumed. Operations proceed as has been discussed before.

We can leave the File Menu, without loading new input data, by entering [9] or [0]. In that case,
the input data, as stored in memory, remain unaffected.

In Fig. 4.1 on the following page, the related (sub)-menus are schematically shown.
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—— MAN NENU

#

FILE NENU
LOAD INPUT DATA

Fig. 4.1 - The File Menu for loading the input data.
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5. View input data.

With the option View input data one can browse the input data to see the current values of the
data which will be used when performing a simulation. The input data will be shown on the
screen in exactly the same way and order as they are stored in the input file (Appendix A). An
example of a screen with input data is shown in Fig. 5.1.

******************************

*x MASS PROPERTIES * %
T Y T 22 222222 222 2 2 L S b

Number of mass elements 1
x*xxxkxx***> Data for mass element # 1

.4976000000D+04

Mass at epoch (kg) 0

X-coordinate CoM (m) © =0.2570000000D+01
Y-coordinate CoM (m) 0.0000000000D+00
Z-coordinate CoM (m) 0.1370000000D+00
Ixx (kg m"2) 0.5617605456D+04
Iyy (kg m"2) 0.4454623056D+04
Izz (kg m"~2) 0.4454801760D+04
Ixy (kg m"2) 0.0000000000D+00
Ixz (kg m*2) "0.1751999840D+04
Iyz (kg m"2) 0.0000000000D+00

Next screen <Y/N>? <Default = Y>

Fig. 5.1 - A screen with input data, as can be seen with the option View input data.

At any time the user can decide either to see the next screen or to return to the Main Menu.
For the next screen, the user can enter [Y] or simply press [Enter], because the default setting
is [Y]. Entering [N] results in the return to Main Menu. The same will happen when the last
screen of input data has been shown.
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6. Edit input data.

6.1. The Edit Menu.

Editing the current set of input data is possible, by choosing option 3 of the Main Menu. The
Edit Menu, which is given below (see also Fig. 6.1), shows that the input data can be divided
into four separate modules. Each of these data blocks will be described in the four following
Sections. Options 9 and 0 of the Edit Menu result in an immediate return to the Main Menu.

— MAIN MENU

'

EDIT MENU

__J¢
r i ¢ ¢

VEHIQLE MENU ENVIRONMENT MENU MISSION MENU SIMULATION MENU

Fig. 6.1 - The Edit Menu.
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6.2. Editing re-entry vehicle related data.
6.2.1. The Vehicle Menu.

The input data dealing with the re-entry vehicle can be divided into five categories. The first
category of input data consists of the mass properties of the spacecraft, i.e., the mass, the
location of the Centre of Mass (CoM) and the inertia properties. The second category deals with
the aerodynamic properties of the re-entry vehicle. In this data block, the reference geometry
to compute aerodynamic forces and moments is placed. The third category describes a major
subsystem of the re-entry vehicle, namely the parachute system. In the fourth category we find
external forces and moments, which may act on the re-entry vehicle next to aerodynamic, gravi-
tational and propulsive forces. The fifth category, finally, characterizes the propulsion system.

This subdivision can also be found in the Vehicle Menu, as depicted below. However, the inertia
properties and the reference geometry have been given a separate menu entry for practical pur-
poses and with respect to future extensions of the program. The menu entry marked with an
asterix cannot be chosen, despite the fact that it has been implemented in the user interface.
This topic, thermodynamics, is part of future extensions.

Options 9 and 0 can be chosen, when the user wants to return to either the previous menu, i.e.,
the Edit Menu, or the Main Menu. The relation of the several layers of the menu structure can
be found in Fig. 6.2 on the following page.
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Fig. 6.2 - The Vehicle Menu.

6.2.2. Mass properties.

The re-entry vehicle can be thought to consist of a number of distinct elements, from now on
called mass elements, which, when linked together, correspond with a solid body having the
same mass properties as the re-entry vehicle as a whole. In this way, the re-entry vehicle can
be modelled with basic geometrical shapes (spheres, cones, boxes, etc.) of which the mass
properties are known or easy to calculate.

In order to define a number of mass elements, with a fixed distance between each other, it is
necessary to define a reference frame in which the coordinates of the mass elements can be
expressed. This reference frame has its origin in the so-called aerodynamic reference point, the
point with respect to which the aerodynamic force and moment coefficients are defined. The
direction of the axes is arbitrarily, as long as this definition will be used consistently. From now
on, if we speak about a reference frame, the above mentioned frame is meant.

Entering [1] from the Vehicle Menu (option Mass properties), first allows from the user to enter
the number of mass elements. Up to a maximum number of 10 mass elements can be defined.
If any configuration change (see Section 6.4.4) has previously been defined, and the number
of mass elements is decreased, the number of configuration changes will be reset to zero,
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because they are directly linked with mass element numbers. Nota bene: the variables related
with the configuration changes keep their values in that case, so the user can easily redefine
the configuration changes.

Per mass element, the user must give the mass m at epoch (time of re-entry) in kg and the
location of the COM, X Yo and Zg,,,in m, expressed in coordinates of the reference frame.
The mass must be greater than zero, while the CoM can have either positive or negative
coordinates.

If only one mass element has been defined, we will return to the Vehicle Menu after having
entered the last value (the Z-coordinate of the CoM). In case the number of mass elements is
greater than one, the user is asked to continue with the next mass element. Entering [Y] asks
for the mass and location of the CoM of the next mass element, while entering [N] results in
a return to the Vehicle Menu.

6.2.3. Inertia tensor.

For computations of the angular rates of the re-entry vehicle, the so-called inertia tensor / is
used. It is defined as

hex 'lxy Iz
I=\"hy ly Iy

~Iyz - yz Iz2

As can be seen from the above definition, /is symmetrical. Therefore, only 6 out of the 9 inertia
elements have to be defined, namely

. .. 2
Iy 1y @Nd /5, the moments of inertia in kg m

and

Ly Iz and /, the products of inertia in kg m?
Using the concept of mass elements, gives rise to the values of the-moments and products of
inertia for each of the mass elements. Because it is not convenient to define the inertia
elements with respect to the reference frame, so-called local frames are introduced. A local
frame has its origin in the CoM of a mass element and has the same orientation as the (global)
reference frame. This means that the X-, Y- and Z-axis of the local frame are collinear with the
corresponding axes of the global reference frame and positive in the same direction. Iin other
words, the local frames are not rotated with respect to the global reference frame.

Per mass element, the moments and products of inertia are defined with respect to the
appropriate local frame.
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Entering [2] from the Vehicle Menu (option Inertia tensor) enables the user to edit the inertia
elements. Successively, the user can alter :

hoo lyy and /,,; by definition these values must be greater than 0

and

Iy Ixz and I, values can be either positive or negative
Nota bene: if a mass element is rotational symmetric, all the products of inertia are equal to
zero.

If only one mass element has been defined, we will return to the Vehicle Menu after entering
the last value (i.e., Iyz). In case of more than one mass element, the user can choose between
editing the inertia tensor of the next mass element and returning to the Vehicle Menu. Having
edited the last mass element will also result in a return to the Vehicle Menu.

6.2.4. Reference geometry.

The reference geometry is defined for the complete re-entry vehicle, and consists of the
reference length and area for which the aerodynamic coefficients are defined and the reference
length on which the Reynolds number is based. Usually, the two reference lengths are the

same.

After entering [3] from the Vehicle Menu (option Reference geometry), the user can
successively change

the reference length d (m) for the aerodynamic coefficients
the reference area S (m2) for the aerodynamic coefficients
the reference length L, (m) for the Reynolds number

It is obvious, that each of the values entered must be greater than zero. After entering the value

for L, we return to the Vehicle Menu.

6.2.5. Aerodynamics.
6.2.5.1. The Aerodynamics Menu.

The major part of the input data consists of the aerodynamic properties of the re-entry vehicle.
These data are an integral part of the input file. However, it is also possible to store the
aerodynamic data in a separate file, the so-called aerodynamic database. This way of storing
enables the user to select a different aerodynamic database when there is a configuration
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change, which may affect the aerodynamic properties (e.g., the jettisoning of an aerodynamic
decelerator). We will discuss this in more detail in Section 6.4.4. :

The aerodynamic coefficients and related data can be entered and edited by choosing option.
4, Aerodynamics, from the Vehicle Menu. The resulting Aerodynamics Menu, as shown below,
enables the user to load or save an aerodynamic database, to enter aerodynamic coefficients
and to define the way of table extrapolation, which has to be used during the simulation. As is
obvious from the menu, there are two ways of defining the aerodynamic coefficients.

The first way (option 2, Coefficients for axisymmetric body) makes use of the fact that the
re-entry vehicle is an axisymmetric body. This means that the aerodynamic representation of
the re-entry vehicle is restricted to only three (independent) aerodynamic coefficients, related
with symmetrical motion, namely

Cp : the drag coefficient
C, : the lift coefficient
C,, : the pitching moment coefficient’

The second way of aerodynamic modelling (option 3, Coefficients for non-axisymmetric
body) enables the user to fully define the aerodynamic properties of the re-entry vehicle. Six
independent coefficients can be entered, namely

Cp : the drag coefficient
Cg : the side force coefficient

C, :the lift coefficient

C, : the rolling moment coefficient

C,, : the pitching moment.coefficient
C, :the yawing moment coefficient

As we will see in Section 6.2.5.3, the aerodynamic coefficients can be entered as tables, as a

3 The force cosfficients are defined with respect to the Aerodynamic Frame and the moment coefficients with
respect to the Body Frame. :
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function of flight parameters. For flight conditions outside the table range, the actual coefficients
can be computed according to different schemes. Choosing option 4 (Extrapolation method)
from the Aerodynamics Menu enables the user to define one of these schemes.

m— MAN MENU

'

EDIT MENU

'

VEHICLE MENU

'

=1 AERODYNAMICS MENU

'

FILE MENU
AERODYNAMIC DATABASE

]

Fig. 6.3 - The Aerodynamics Menu.

Entering [9] results in a return to the Vehicle Menu, see also Fig. 6.3, and [0] in a return to the
Main Menu. Before the actual return to one of these two menus, a check is made whether there
is no inconsistency in the definition of the aerodynamic coefficients. In short, the inconsistency
can be described as follows. The aerodynamic coefficients cannot be based on both the angle
of attack o and the total angle of attack o at the same time. And, because ar has been intro-
duced to be used in combination with an axisymmetrical body only, it cannot be defined for a
non-axisymmetrical body. As long as this inconsistency has not been solved, one cannot leave
the Aerodynamics Menu and an error message is given when one tries. We will come back to
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this inconsistency, when we are dealing with the (non-)axisymmetrical body.

6.2.5.2. Loading and saving an aerodynamic database.

When either option 1 (Load aerodynamic database) or 5 (Save aerodynamic database) is
chosen from the Aerodynamics Menu, the default name of the aerodynamic database and the
following File Menu are shown on the screen:

The default name of the aerodynamic database can be 'AERO.DAT’, which is the program
default, or the last user-specified name.

The File Menu introduced above is the same as presented in Chapter 4 (Load input data). The
discussion given in there also holds for this File Menu w.r.t. loading the aerodynamic database.
It is briefly repeated here.

The default database name can be either accepted (option 1) or changed (option 2). Entering
a 'blank’ name (option 2) also implies the use of the default filename. When the indicated
database is not found, an error message is given. We can enter another filename (option 2) or
decide to leave the File Menu (options 9 and 0). Also an I/O-error during the read process
results in an error message and a return to the File Menu. By choosing option 9, we can go up
one level in the menu structure, which means in this case that we arrive at the Vehicle Menu
again (see Fig. 6.4). Entering [0] results in a return to the top level of the menu structure, the
Main Menu. When the aerodynamic database has been successtully loaded, the Aerodynamics
Menu appears on the screen.

Saving an aerodynamic database is not much different. The user can either accept the default
database name, as shown above the File Menu, by entering [1), or change the filename by
entering [2]. In both cases, a check is made whether the given file already exists. A warning
is given if this is true, and the user can decide to overwrite the existing file or to return to the
File Menu, to change the filename. When the database has been successfully saved, control
is returned to the Aerodynamics Menu. An /O error during the write process results in aborting
the process and a return to the File Menu. An error during the write process will not affect the
data stored in memory, of course.
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Fig. 6.4 - File Menu for loading or saving the aerodynamic database.

6.2.5.3. Edit coefficients for axisymmetric body.

Before we discuss the Axisymmetric Body Menu, we will shortly describe how aerodynamic
coefficients are modelled. As has been stated in Section 2.1, the aerodynamic coefficients are
expanded in a Taylor series. A coefficient can have the following form

CF=CF,+ CFyyX1 + CFysX2 + ... + CFX,'XQ-X1 X2 + ...

Each of the terms CF,, CFyj,, ... are the coefficient components. X1, X2, ... are the multipli-
cation terms (also called derivation variables). Each of the coefficient components can be a
function of so-called table variables, so that the aerodynamic coefficient can be dependent on
flight conditions. If the number of table variables equals zero, then the coefficient component
has a constant value.

Entering [2] from the Aerodynamics Menu, Edit coefficients for axisymmetric body, gives the
Axisymmetric Body Menu, as shown below, on the screen (the related menu structure is shown
in Fig. 6.5).
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Fig. 6.5 - The Axisymmetric Body Menu.

As has been mentioned before, only three aerodynamic coefficients have to be defined to fully
describe the re-entry vehicle. However, there are some restrictions. It must be noted that with
this way of modelling, the rolling moment coefficient C,is always equal to zero. When the user
wants to enter a rolling moment coefficient, which is unequal to zero, he has to use option 3
of the Aerodynamics Menu, Edit coefficients for non-axisymmetric body. In order to take the
remaining asymmetrical force and moment into account (side force and yawing moment), the
three symmetric coefficients must be defined as a function of the total angle of attack, ap
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instead of the angle of attack a. In that case, the aerodynamic coefficients are so-called total
coefficients, combining the dependency on angle of attack and angle of sideslip. Using a, Cg
and C, are derived from the total lift-force coefficient and C, and C, from the total pitching
moment coefficient*. Cp, can directly be obtained from the total drag coefficient.

There is one flight condition, where this way of modelling cannot be used. If a; = =, there is a
singularity in the equations computing the aerodynamic coefficients. This flight condition
corresponds with a ballistic (@ = = and B = 0°) or close to ballistic (@ = = and B = 0°) entry. The
user has to be aware of the flight conditions encountered during the simulation, in order to use
armodelling.

Returning to the Axisymmetric Body Menu, we see five menu entries, three for editing
coefficients and the usual two to return to the previous menu or the Main Menu.

Because editing each of the coefficients is done in the same manner, we will restrict the
discussion to only one coefficient. Entering [1], [2] or [3] enables us to enter or change
coefficient components. When the selected coefficient has not yet been defined - the number-
of coefficient components is zero - the user is asked whether he wants to enter a coefficient.
Entering [Y] results in a number of data he has to enter, after [N] we return to the Axisymmetric
Body Menu. On the other hand, if the selected aerodynamic coefficient has already been
defined (the number of components is not equal to zero), the related data of the first coefficient
component are shown on the screen, together with a menu from which we can start some
actions.

Let us suppose the number of components was zero. In this case we immediately begin with
entering the necessary data. The first number we must enter is the order of derivation. This
value can be either 0, 1 or 2. Depending on this input are the next input data. When the order
of derivation is 1 or 2, we must also enter the derivation variable(s). For this reason, the
following table is printed on the screen:

4 It aerodynamic damping is included in the total pitching-moment coefficient, then this damping is dependent
on the angular pitch rate. This implies, that a rotation about the Y-axis (pitch) is used to damp a rotation about
the Z-axis (yaw). It may be clear, that despite the fact that we are dealing with an axisymmetrical body, this is
not altogether realistic. . :
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with below this table, the default value for the first derivation variable and the possibility to enter
the new value. We can enter any value between [1] and [7]. Nota bene: the first entry, i.e., -0-
none, has been added to show as default value when we have changed the order of derivation
from O to 1 or 2. Since none for a derivation variable has no meaning (it would lower the order .
of derivation), [0] cannot be entered. The only way to change the order of derivation is directly,
when we have to enter the order.

After entering the first variable of derivation, we have to enter the second one as well (if the
order is 2)5. After the derivation variables, the number of table variables must be entered.
Table variables are the independent variables of which a component can be a function. The
number of table variables can be either 0, 1 or 2. When this number is 0, it means that the
component has a constant value, independent of flight conditions. This constant value of the
component must be entered next.

A number of 1 or 2, however, means that the value of the component may change during the
flight. The following table appears on the screen

with below this table the default value for the first table variable. Here, the same principle as
with the derivation variables has been applied. Only variables [1] to [6] can be chosen; [0] has
been added to serve as default value, when necessary. In case there are two table variables,
we must also enter a value for the second one (or pressing [Enter], if we want to accept the
default value, as long as it is not 0).

Next, we can change the number of table entries for the table variable(s). Any value between
1 and 10 can be entered (0 would mean that definition of this table variable has been useless,
so therefore it has been excluded).

5 In principle, we assume a linear Taylor series. The fact that the order of derivation can be 2, which means
a second derivative, is used to be able to define cross-derivatives (which stand for non-linear terms, but only a
first derivative with respect to one variable). if the order is 2, and we choose for both derivation variables the
same variable, this means that we have a second derivative with respect to this one derivation variable. In a
Taylor series, the corresponding multiplication term would be X 12/2, with X1 as the derivation variable. However,
in START two different table variables are assumed, so therefore the multiplication term is not divided by 2, if
we define two identical derivation variables. In the case, that defining such a second derivative is necessary, the
user must divide the coefficient component itself by two before entering.
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The next set of input data deal with the entries for the table variable(s) (NOT the entries for the
coefficient component; these have to be entered:-later). For each entry, a default value appears
on the screen, which we can either accept (by pressing [Enter]) or change. Nota bene: o, f and
ar must be entered in degrees, not in radians.

It is important to know, that the entries of the table variables can be in arbitrary order. After
having entered the component entries, the table is sorted, i.e., the smallest table variable (and
corresponding row or column with component entries) comes first and the other will be in
ascending order. This sorting is done for interpolation purposes.

Depending on the number of table variables, and the number of entries per table variable, is
the number of entries for the actual coefficient component. For a component, depending on two
table variables with 10 entries each (the maximum number), the user has to input 100 values
for the coefficient component. Entering a component depending on two table variables, means
that the component is represented by a matrix. The values of the component are entered
column-wise, in that case.

When we enter the values for the component, the values of the table variables for the current
entry are shown on the screen. In this way, the chances to erroneously enter component values
have significantly decreased.

Having entered the last entry of the coefficient component, the most important parameters are

shown on the so-called overview screen. From this screen it is possible to change any
parameter. We will discuss this in more detail after the following example.

Example.

Suppose we want to enter the damping term C,,,q of the pitching moment coefficient, defined
as

d
Cm= Cmo M Cmq -gv-

with
g = angular pitch-rate with respect to rotating planetocentric frame (rad/s)
d = aerodynamic reference length (m)

V = relative flow velocity (m/s)

We assume that the first component, Cmo, has already been entered and that we are about to

enter the order of derivation of the second component, Cmq.
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The order of derivation is equal to 1. After entering [1], we see the table with derivation
variables on the screen, the default value of this variable and the question to enter the value
of the derivation variable (again: by pressing [Enter], we can accept the default value). Suppose
the default value is not the correct one. In that case we enter [6], for g *d / V.

The next input data deal with the table variables. In our example, the damping term is given as
a tabulated function of Mach number and total angle of attack, as indicated in Fig. 6.6.

C(M,.ar ) C(M,ar ) C(M,,013) C(M,ary C(M,.ar 5
C(Mz,ar' ) C(M?ar, 2 C(Mz,ar' 2 C(Mz,aT‘ P C(Mz,aT' s
CMzor,) | CiMaary) | CMzarg | CiMzary | CiMaars
C(Mgar,) C(Mgar o) C(Mgar3) C(Mgory C(Mgarg
C(Ms.or ) C(Msar ) C(Msar3) C(Msar C(Ms.ars)
Fig. 6.6 - Example of an input table for the aerodynamic coefficient component Cas

a function of the two independent variables M and a.t.

For the number of table variables, we enter [2]. The next four questions we answer with

Table variable #1, default = 0, i.e. none
Input new value (Enter to proceed): [5]

Table variable #2, default = 0, i.e. none
Input new value (Enter to proceed): (3]

The number of entries for variable #1, default =1
Input new value (Enter to proceed) : [5]
The number of entries for variable #2, default = 1

Input new value (Enter to proceed) : [5]

Nota bene: the default values given here, are just examples. They may differ per program
session.

Next, we enter the values for the two table variables, first M, to M5 and then ar, 10 a7
Finally, we must enter the 25 component entries per column. So we start with C(M.a.r,) to
C(Mgar ), then C(M,,ar ) to C(Ms07 o), etc. Having entered the last entry, i.e., C(Msar 5,
the overview screen of Fig. 6.7 appears.
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Pitching moment equation
Component #2 of 2

Order of derivation : 1
Ref. var. of deriv. #1 t:gq*xd/ Vv
Ref. var. of deriv. #2 : none

Number of table variables : 2

Table variable #1 : Mach number

Number of entries var. #1 : 5

Table variable #2 : total angle of attack (deq)
Number of entries var. #2 : 5

-1- Change any parameter. -9- Return to previous menu.

-2- Add component.
-3- Delete component.

Enter the number of your choice:

Fig. 6.7 - Overview screen for an aerodynamic-coefficient component.

We can now return to our discussion of entering and changing coefficients. The above screen
is also shown, when we choose from the Axisymmetric Body Menu one of the three coefficients,
and they have already been defined previously. Depending on the number of coefficient
components is the Coefficient Menu. If the aerodynamic coefficient consist of only one
component, we see the menu as shown below.

Choosing option 1, Change any parameter, we arrive at the same set of questions as
discussed before. It is now possible to fully redefine the component. Of course, the current
(default) values are shown for each variable. '

With the second option, Add component, we can define a new component, which belongs to
the current coefficient. Suppose we have defined the lift coefficient with one component, C,_o,

and we want to add a first derivative, C,_u, so that the total expression for the lift coefficient will
be
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CL=CL° +C,_u-a

then we can use this option. The number of components, which can be added is depending on
the coefficient. For each of the coefficients, a maximum number of components has been
defined. These are

Cp : 2 components
C, : 5 components
C,, : 8 components

Adding a component, while the maximum number has already been used, results in an error
message.

After adding a component, we return to the overview screen from which we entered the Add
component option. This means, that for a coefficient with three components already defined,
entering [2] (adding the fourth component) from the overview screen of the first component, we
will return to the overview screen of the first component and not to the screen for this last
entered component. Of course, it is possible to view this overview screen. We will come to that
later.

With option 3, Delete component, we can remove the current component, i.e., the one
currently shown on the screen. Due to the radical nature of this action, the user is asked for
confirmation. Entering [Y] results in the actual deletion, while [N] will not affect the component
definition. In that case we return to the overview screen. After deleting the current component,
we return to the overview screen, where the next component (if any) is shown, or the previous
one (if we deleted the last one). In case we deleted the only one component, we will return to
the Axisymmetric Body Menu.

With option 9, Return to previous menu, we can retum to the Axisymmetric Body Menu, as
indicated in Fig. 6.5.

Up to now, we assumed that only one component had been defined. However, it is of course
also possible that a coefficient consists of more components. In that case, it must be possible,
when we have seen (or edited) the first component, to see the next one. For this reason, we
see in the case of more components, a slightly different menu.
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This menu will be shown on the overview screen, as long as there are more components to
show. It is NOT possible to go back to a component. In that case, we have to retum to the
previous menu, and select the same coefficient, so that we begin with component 1 again. The
use of this menu is identical to the one described above. The only difference is that the option -
Show next component has been added.

6.2.5.4. Edit coefficients for non-axisymmetric body.

" Choosing option 2 from the Aerodynamics Menu, Edit coefficients for non-axisymmetric
body, we can fully define the aerodynamic properties of the re-entry vehicle. We have three
force and three moment coefficients at our disposal now, as can be seen in the Non-axisym-
metric Body Menu below.

The discussion given in the previous Section about the coefficients for an axisymmetric body
is without change also applicable to the coefficients for a non-axisymmetric body. We therefore
refer to that Section. The maximum number of coefficient components, which can be defined,
are:

Cp : 2 components

Cg : 5 components

C, :5 components

C, :5 components

C,, : 8 components

: 8 components

With options 9 and 0 we can return to the upper layers of the menu structure, as is also shown
in Fig. 6.8.
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Fig. 6.8 - The Non-axisymmetric Body Menu.

6.2.5.5. Extrapolation method.

As we saw in the previous two Sections, the aerodynamic coefficients can be represented by
tabulated functions of flight parameters. Depending on the actual flight condition, the correct
value of the aerodynamic coefficient is computed by means of linear interpolation. When the
flight conditions are such, that the actual values of the table variables are outside the table
range, special care has to be taken.

We can define the way of extrapolation for those cases outside the table range. We enter [4],
Extrapolation method, from the Aerodynamics Menu. Then, the default choice for extrapolation
is shown, together with the Extrapolation Menu, as presented below:
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Fig. 6.9 - The Extrapolation Menu.
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The first three entries give the possibilities for extrapolation. Coefficient not defined means,
that when the flight conditions are such that they are outside the table range, the aerodynamic
coefficient is not defined. This results in an eror message during the simulation, which is
aborted consequently.

Option 2, Use boundary value means the following. Suppose table variable #1 is the Mach
number, with 5 entries, such that

M1<M2<M3<M4<M5

If the actual Mach number, M, is smaller than M,, this latter value is used. Also when M > M,
the coefficient value for Mg is used.

With Extrapolation (option 3), the coefficients are computed by means of linear extrapolation.
It must be noted, that when the difference between actual values and boundary values of the
table are large, the coefficient values may be too large or too small. The user must decide on
basis of table range and occurring flight conditions whether this option can be used.

After selecting an extrapolation method, we retum to the Aerodynamics Menu. Entering [9] or
[0] results in a return to the Aerodynamics or Main Menu, respectively (Fig. 6.9).

6.2.6. The parachute system.

The following characteristics underlie the parachute model. The parachute/payload system is
considered to be one single body. The equations of motion describe the translation of the global
CoM of the system and the rotation around this CoM. The equations of translational motion are
based on cartesian coordinates, in order to overcome the singularity for spherical coordinates
when a vertical motion is studied. To describe the attitude of the system, quaternions are used.
The effect of wind is taken into account.

Both the parachute and the re-entry vehicle are thought to be rigid bodies (no mass points),
connected by a rigid bar. This rigid-bar connection prevents the two bodies to rotate w.r.t. each
other. However, the two bodies can have a relative spin rate w.r.t. each other, because a (non-
ideal) swivel has been implemented in the connection between parachute and re-entry vehicle.
Non-ideal means in this case, that the swivel causes a friction moment which counteracts the
spin rate.

The air in and under the parachute is taken into account as added mass. The shape of the
canopy is taken as a hemisphere.

To minimize the CPU-time usage, the parachute/payload system is considered to be rotational
symmetric. In that case, the inverse of the inertia tensor does not have to be computed every
time step, since there exist an analytic form of the Euler equations for a rotational symmetric
body. Nota bene: the inertia properties of the system change continuously because of the
added mass, which is dependent on the atmospheric density and therefore on height.
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6.2.6.1. The Parachute Menu.

‘ Entering [5] from the Vehicle Menu, Parachute System, gives the following Parachute Menu
on the screen (see also Fig. 6.10).

DT v

PARAGHUTE NENJ
LOAD PARAGIVTE SYSTEMS NABER OF SAVE PAROUTE SYSTEMS
ALE MO PARAGUTE WODEL PARACAITE SYSTMS €O PARAGAITE SYSTM FLE MW

Fig. 6.10 - The Parachute Menu.

As can be seen from the first and fifth entry of this menu (Load parachute systems and Save
parachute systems, respectively), all parachute-related data are treated as a separate entity,
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a so-called parachute database. This makes it easy to use an already defined parachute system
with other vehicles.

The parachute model defined in START Version 1.0 is a 2D, 3 dof one. Both the entry vehicle .
and the parachute are represented by mass points, connected by a rigid bar. The model is rela-
tively fast and gives qualitatively good results, as long as the influence of wind is not consi-
dered. The current model is a 3D, 6 dof parachute model, where the entry vehicle and the para-
chute are treated as (symmetrical) rigid bodies, still connected by a rigid bar. The model gives
more accurate results (especially when the influence of wind is studied), but is computationally
more intense. In the current version of the software, only the new model can be used, but for
the future it is foreseen that the old model will be reimplemented as an alternative model. For
this reason, menu entry 2 (Parachute model (2D/3D) has already been implemented.

A parachute system can be edited (option 4, Edit parachute system), once at least one (up
to a maximum of three) parachute system has been defined with option 3, Number of para-
chute systems. Entering [9] or [0], results in a return to the Vehicle Menu or Main Menu,
respectively (Fig. 6.10).

In the following Sections, each of the menu options will be discussed in more detail.

6.2.6.2. Load and save parachute systems.

Choosing option 1, Load parachute systéms. or option 5, Save parachute systems, gives
the name of the currently defined parachute database, and the following (familiar) File Menu.

The parachute-database filename can be 'PARA.DAT’ (program default) or the last user-
specified name.

Loading or saving the parachute database is executed in the same manner as has been
described in Chapter 4 or Section 6.2.5.2. For the sake of convenience, we will briefly repeat
the procedure. We begin with loading a database.

We can either accept the default database name by entering [1] or change the name by
entering [2]. Entering a 'blank’ name (option 2) also implies the use of the default filename.
When the indicated database is not found, an error message is given. We can enter another
filename (option 2) or decide to leave the File Menu (options 9 and 0). Also an I/O-error during
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the read process results in an error message and a return to the File Menu. The parachute
data, which may have been distorted by the 1/O error are reset to the default values. This
means that no parachute systems are assumed. '

—— MAIN MENU

EDIT MENU

'

VEHICLE MENU

S . PARACHUTE MENU

'

FILE NENU
PARACHUTE DATABASE

]

Fig. 6.11 - File Menu for loading and saving the parachute database.

By choosing option 9, we can go up one level in the menu structure, which means in this case
that we arrive at the Parachute Menu again (see Fig. 6.11). Entering [0] results in a return to
the top level of the menu structure, the Main Menu. When the parachute database has been
successfully loaded, the Parachute Menu appears on the screen.

When we are saving a parachute database, we can specify the filename in exactly the same
way as mentioned above. Once a valid name has been entered, a check is made whether the
given database already exists. A warning is given if this is true, and the user can decide to
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overwrite the existing file or to return to the File Menu, to change the filename. When the data-
base has been successfully saved, control is returned to the Parachute Menu. An 1/O error
during the write process results in aborting the process and a return to the File Menu. An error
during the write process will not affect the data stored in memory.

6.2.6.3. Number of parachute systems.

Choosing option 3, Number of parachute systems, from the Parachute Menu it is possible to
define the number of parachute systems. The maximum number of parachute systems is three.
It is important to know, that if more than one system have been defined, all systems are taken
into account when the mass properties of the complete entry vehicle are determined. Defining
three parachute systems does not mean that we can only use one system during the mission;
in fact, all three systems can be deployed, although it should be noted that a second parachute
system can only be activated when the first one has been released.

Some remarks

« Decreasing the number of parachute systems does not erase the actual parachute data.
However, they are not taken into account any more while simulating a mission. Increasing
the number again, would show that the data are unaffected. This option is convenient,
when one want to see the influence on the mass properties of the complete entry configu-
ration. By decreasing the number with one, we can study the effect of the last defined para-
chute system.

«  When the parachute systems are stored in an input file or a parachute database, only those
parachute systems are stored, which have been defined by the number of parachute sys-
tems (starting with system 1, 2, and finally 3, if applicable).

» By decreasing the number of parachute systems, always the last defined system is
removed first. It is not possible to copy the third system, for instance, to the first system.
When parachute systems use the same aerodynamic database, these data have to be
entered for each system. They cannot be copied either.

6.2.6.4. Edit a parachute system.

To Edit a parachute system (option 4 from the Parachute Menu), at least one parachute
system must be defined. In case no parachute systems are defined, an error message is given,
which tells the user that it is not possible to edit a parachute system. Accepting the error
message (by pressing [Enter]), we return to the Parachute Menu. There, we can use option 3
(Number of parachute systems) to define the number of parachute systems.
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Fig. 6.12 - The Parachute Data Menu.

If we have defined a certain number of parachute systems, we can edit one. This is indicated
by the Parachute Data Menu, as shown on the next page (see also Fig. 6.12):
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Choosing either option 1, Mass and geometry, or option 2, Aerodynamics, the user is first
asked to enter the number of the parachute system, which he wants to edit. This number must
be between 1 and the maximum number of defined parachute systems (this maximum number
is indicated on the screen). Entering an invalid number results in a restatement of the question.
Once a valid number has been entered, one can proceed with entering either mass and
geometry or aerodynamic data, as will be explained below.

Mass and geometry

A schematic overview of the mass and geometry of the parachute system is shown in Fig. 6.13.

XB *
Do

Mp
|~ PARACHUTE
Lt
SUSPENSION LINES ls
)
L—— RISER
oM:]
Xt \ ,/ > I3

ENTRY VEHICLE

Fig. 6.13 - Parachute mass and geometry. The parachute system, as shown here,
consists of only one parachute. The origin of the reference (body) frame is
assumed to be coincident with the nose of the entry vehicle.
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The first variable is the number of parachutes (of the currently defined parachute system).
Depending on this number is the following parameter. If the parachute system consists-of more
than one parachute, a so-called cluster coefficient must be entered, with a value between 0 and
1. This cluster coefficient represents the performance loss of the parachute system due to .
clustering of the parachutes. A value of 0.9, for instance, means that the decelerating effect of
the parachute system is only 90% of the nominal value.

The next variable is the parachute mass (mp > 0 kg). Nota bene: the mass of a single para-
chute is meant, although the system may consist of more than one parachute. We assume that
each of the parachutes has the same mass. Following the parachute mass, the mass of the
suspension lines must be entered. Again, this mass is related to a single parachute.

Following the mass properties, the next three parameters define the geometry of the parachute.
Successively, we must give the values for the nominal parachute diameter (D, > 0 m), the
suspension-line length (L, > 0 m) and the riser-line length (L., > 0 m).

As has been mentioned before, in the connection between the parachute and the re-entry
vehicle, a swivel has been implemented. This does not imply that the swivel has to be included
in the model. The user is asked whether a swivel is connected to the riser. Answering [N],
means that the parachute and re-entry vehicle will roll with the same rate. It also means that
the inertia properties of both the parachute and the vehicle are taken into account when the
angular rates are computed. The parachute system truly is a single body, in this case.

On the other hand, when the user decides to connect a swivel to the riser by answering [Y], the
rolling motion of the vehicle is decoupled from the one of the parachute. To be more precise,
the parachute is considered not to roll at all (i.e., no roli rate w.r.t. inertial space). The computed
roll rate is the one of the re-entry vehicle only.

The swivel can be non-ideal, meaning that the rolling motion of the re-entry vehicle causes a
friction moment. Of course, this moment is always counteracting the rolling motion. To include
the friction moment, a so-called friction coefficient has to be specified. The unit of this (positive)
coefficient is ‘meter'. Entering '0', results in an ideal swivel with no friction.

The connection of the riser to the vehicle is called the attachment point. Since we consider the
parachute system to be a rotational symmetric body, only the x-coordinate of the attachment
point has to be specified. This value concludes the input set of the parachute in deployed state.

The following data the user has to provide, deal with the mass properties of the parachute
system in packed condition. We must give the location of the CoM of the packed parachute
system, i.e., Xy Yom and Z,, (in m) and the values of the inertia tensor, /. 1, and /I, (the
moments of inertia in kg m2) and Xy l,,and I . (the products of inertia in kg m©) Nota bene:
because it is possible that these data are not known it is possible to enter "0’ for the moments
of inertia to exclude them. One must take note, that the location of the CoM of the parachute
system must be equal to the global CoM of the re-entry vehicle, or there will be additional
moments of inertia due to the shift of the CoM. After entering the last value, we return to the

Parachute Data Menu.
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Aerodynamics

After selecting the menu entry Aerodynamics (option 2) from the Parachute Data Menu, the

user first has to specify which parachute system he wants to edit. After entering a valid number, -

the following sub menu, the Parachute Aerodynamics Menu, appears on the screen.

We see similar menu entries as before, when we were discussing the aerodynamic properties
of the re-entry vehicle: we can either edit aerodynamic coefficients or choose the extrapolation
method for flight conditions outside the table range.

Although the parachute system is an axisymmetric body, which means that we could have re-
stricted the number of aerodynamic coefficients to three (the "total’ aerodynamic coefficients,
see also Section 6.2.5.3), this approach is not followed here for two reasons. In the first place,
defining "total' aerodynamic coefficients implies that the roll coefficient is always zero. Since it
must be possible to study roll damping, the user must have full access to the aerodynamic coef-
ficients. In the second place, and this is much more important, parachute descent usually takes
place at a 'zero-angle-of-attack’ (in our case a = 180°) and for this value of a, the equations
for transforming the 'total’ coefficients hold a singularity.

After choosing option 1, Aerodynamic coefficients, we arrive atthe following Coefficient Menu.

Entering and editing these coefficients is done in exactly the same way, as for the coefficients
of the re-entry vehicle. Therefore, we refer to Sections 6.2.5.3 and 6.2.5.4. However, there is
one difference for defining coefficients of the parachute system. The number of coefficient
components is in all cases restricted to-only two.
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Fig. 6.14 - The Coefficient Menu, for editing the aerodynamic coefficients of the para-

chute system.

In Fig. 6.14, the related menu structure is given.

For flight conditions outside the table range, we must specify the extrapolation method. This
method is valid for each of the parachute systems defined. Option 2 of the Parachute
aerodynamics Menu, Extrapolation, enables the user to specify the extrapolation method (Fig.
6.15). We refer to Section 6.2.5.5 for more details.
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Fig. 6.15- The Extrapolation Menu for the aerodynamic coefficients of the parachute
system.
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6.2.7. External forces and moments.
6.2.7.1. The External Forces and Moments Menu.

After entering [6] from the Vehicle Menu, option External forces and moments, the following

External Forces and Moments Menu is shown on the screen. At this moment, the menu has -

only one entry, apart from the two entries to leave the menu (see also Fig. 6.16). In the next
Section, we will discuss this entry, Spin vanes.
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Fig. 6.16 - The External Forces and Moments Menu.
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6.2.7.2. Spin vanes.

Option 1 from the External Forces and Moments Menu, Spin vanes, enables the user to select
spin vanes and edit the related data. The spin vanes are small aerofoils, symmetrically mounted
all around the vehicle. These spin vanes cause an additional external rolling moment. The
following aspects underlay the (simplified) spin-vane model (Fig. 6.17).

Each vane is considered to be a rectangular flat plate. The lift and drag contribution for one
vane is computed, based on flat-plate theory. These forces resultin a rolling moment that drives
the descent module. The contribution of all the vanes is taken into account by multiplying the
computed rolling moment by the number of vanes. This implies, that the flow direction for each
vane is assumed to be identical, so, for instance, no transverse winds can be studied.

An
WALL OF
RE-ENTRY VEHICLE RE-ENTRY VEHICLE
SPIN VANE / . St
v
4
Iy [
-

Iy @Y

DRAWING NOT ON SCALE!

() ®)

Fig. 6.17 - The spin-vane geometry: (A) The location of the spin vane is given by the
radial distance r,, and the X-coordinate x, in the reference body frame
(index B). The offset angle of the spin vane w.r.t. the on-coming flow is
indicated by 6, (B) The spin vane as a flat plate; a is the reference length
of the vane for computing the aerodynamic forces. Together with the aspect
ratio A the reference area can be computed. '

Limitations of the developed model are the following:

. flow disturbances due to interactions between the re-entry-vehicle wall and the vanes

are not considered,
« partial visibility of a vane due to shielding of the re-entry vehicle and a deviation in flow

direction is not taken into account,
. the flow direction for each vane is different, unless we consider a vertical descent with
no wind. For realistic computations, wind should be taken into account and therefore,

the forces acting on each vane should be computed separately.

For the spin-vane model, the following set of input data has to be provided. Nota bene: the
default values indicated here, may be different from the ones shown on the screen.

TR RTINSO S TP S R—
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Number of spin vanes (max. 99), default 24

Input new value (Enter to proceed):

Aspect ratio of spin vane, default 0.2000000000D+01

Input new value (Enter to proceed):

0.3250000000D0-01

Reference length (m), default
Input new value (Enter to proceed):

After this value, the screen clears and a second set appears.

0.2700000000D+00

X-distance of spin vane (m), default
Input new value (Enter to proceed):

Radial distance spin vane (m), default 0.6240000000D+00

Input new value (Enter to proceed):

Attitude angle spin vanes (deg), default -0.2000000000D+01

Input new value (Enter to proceed):

Scale factor (> 0), default
Input new value (Enter to proceed):

0.1000000000D+01

Remarks

« The Xg-axis of the reference frame is positive pointing backwards. When the vehicle
is rolling to the right, the roll rate is negative. For increasing the roll rate, i.e., to make
it more negative, the attitude angle of the spin vane has to be negative.

« With the scale (or efficiency) factor, the user can indicate whether the spin vanes are
mounted in a region with increased (or decreased) dynamic pressure. When the dyna-
mic pressure is, for instance, 20% higher where the spin vanes are located, the scale
factor is 1.2. No change in efficiency results in a scale factor of 1, of course.

After entering the last value, the user returns to the External Forces and Moments Menu.

6.2.8. Propulsion system.
6.2.8.1. The Propulsion Menu.

Although at this moment only one engine can be selected and edited, a separate menu - the
Propulsion Menu - has been reserved for editing the propulsion system of the re-entry vehicle.
in the future it is foreseen that the menu will be extended with at least two other elements of
the propulsion system.

Selecting option 7, Propulsion system, from the Vehicle Menu shows the following Propulsion
Menu (see also Fig. 6.18). In this menu, the future extensions are indicated by an asterix. It is
obvious that, apart from the general choices [9] and [0], only option [2], Deorbit-burn engine,
is a valid one. In the next Section, we will discuss this engine in more detail.
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Fig. 6.18 - The Propulsion Menu.

6.2.8.2. The deorbit-burn engine.

The data of the (simplified) deorbit-burn engine can be edited, if we select option 2, Deorbit-
burn engine, from the Propulsion Menu. Simplified in this case means, that the engine can only
be used for 3-dof simulations, i.e., the location and direction of the engine are not included in
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the input data®. Besides, all engine data are considered to be constant.
The user is first asked, whether he wants to select the deorbit-burn engine. Answering [N],
results in a return to the Propulsion Menu, while deselecting the engine. After replying [Y], the .

user is asked for two more data, i.e., the thrust in vacuum (7 > 0 N) and the specific impulse
in vacuum (Isp > 0 s). After entering the value for /., the user retumns to the Propulsion Menu.

6.3. Modelling the environment.

6.3.1. The Environment Menu.

The second block of input data deals with the environment. If we choose option 2 of the Edit
Menu, we get the following menu on the screen: the Environment Menu.

We see four menu entries dealing with the environment. These will be discussed in the
following Sections. Entering [9] results in a return to the Edit Menu, while with [0] we arrive at
the Main Menu. This is schematically shown in Fig. 6.19.

5 For 6-dof simulations, it is necessary to know the exact orientation of the line along which the thrust is
acting w.r.t. the global CoM, because the moment due to the force must be taken into account. For 3-dof
simulations it is sufficient that the magnitude and direction of the thrust force are known.
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6.3.2. Central body.

Fig. 6.19 - The Environment Menu.

In START, itis possible to perform entry simulations to four different central bodies. Depending
on the choice of the selected central body, are planet-related parameters, such as equatorial
radius and the rotational rate of the planet. These parameters are invisible to the user. They
are automatically adjusted, when we choose a different central body. We can do this by
entering [1], Central body, from the Environment Menu. First, we see the default choice of the
central body and a menu with the available central bodies.
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We can select one of the 4 central bodies by entering [1], [2], [3] or [4]. [9] and [0] will leave
the current selected central body unaffected, and we return to the Environment Menu and Main
Menu, respectively. After selecting a central body, we return to the Environment Menu.

The numerical values of the parameters, which are adjusted by changing the central body, are:
Earth
e = 1/298.257

R, =6.378139:10°m
Wy = 7.29211510°° rad/s

Moon
e =0
R. =1.738210°m

Wy = 2.6617-10° radss
Mars
e =1/192

R, =3.40210°m
Wy = 7.0882:10°° rad/s

Titan
e =0
R =257510°m

e
@, = 4.54810° radss

with

e = elipticity
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R, = equatorial radius

w,, = rotational rate of the central body (along Z-axis of rotating planetocentric frame)

Linked with the choice of the central body is a default setting for the gravitational and
atmosphere models. For each of the central bodies these are:

Earth
Gravitational model: central field with J,, J3 and J, included
Atmosphere model: Simple Earth (tabulated)

Moon
Gravitational model: central field with J, included
Atmosphere model: No atmosphere

Mars
Gravitational model: central field with J, included
Atmosphere model: Mars Viking-1

Titan

Gravitational model: central field
Atmosphere model: Nom. Lellouch-Hunten Oct. 87

6.3.3. Gravitational model.

Linked with the selected central body is the choice of the gravitational model. Entering [2] from
the Environment Menu, the current selected central body with corresponding gravitational model
is shown. The menu with the available models is depending on the central body. For each of
the four central bodies, the menu will be presented.

For the Earth, we get the following menu on the screen.



Organization: TUD/LR/A2R . Date: July 1993
Document code: LR-726 Page: 51

Here, the Jterms are the so-called harmonics, representing the inhomogeneity of the mass
distribution. Each of the models can be selected by entering the corresponding number. [9] or
[0] result in a return to the Environment Menu or the Main Menu, without affecting the currently
selected model. After selecting a gravitational model, we return to the Environment Menu.

For the Moon and Mars, we can only choose from 2 models:

For Titan, we cannot choose. Only the central field model is available, which is automatically
selected. This is displayed as a message on the screen, when we try to change the
gravitational model. Pressing [Enter] results in a return to the Environment Menu, in that case.
The numerical values of the gravitational parameters are:

Earth.

L =3.9860047:10" m3/s2
J, = 1.08262710°

J; =-253610°
Jy =-1.62310°
Moon.

g =4.9026510'2 m¥s?
Jy =210
J; and J, are not defined
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Mars.
L =4.31710"3 m¥s?
J, =1.9107°
J; and J, are not defined

Titan.

i =8.9781-10'2 m¥s?
J» Jyand J, are not defined

with

i = gravitational parameter

J» Jz and J, = zonal harmonics
6.3.4. Atmosphere model.
Choosing option 3, Atmosphere model, from the Environment Menu enables the user to select
(or deselect) an atmosphere model. The availability of models is again depending on the
selected central body. After selecting an atmosphere model, we return to the Environment

Menu.

First, the selected central body and atmosphere model are shown, plus a menu with possible
choices. For the Earth, we get the following table.

Each of the models can be selected, by entering the corresponding number. The maximum
altitudes for which the models are valid, are:

US Standard Atmosphere 1962: 700 km
US Standard Atmosphere 1976: 120 km
Tabulated CIRA86 (Kourou): 1000 km
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Entering [9] leaves the current selected atmosphere model unaffected. We return to the
Environment Menu, in that case.

If the central body is Mars, the following table is shown:

The height limitation for Mars Viking-1 is 200 km.

For Titan, we get:

The maximum altitude for which the three models are valid is for each one the same: 1250 km.

6.3.5. Perturbations.
6.3.5.1. The Perturbations Menu.

Entering [4], Perturbations, from the Environment Menu gives the Perturbations Menu, as
shown below.
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Entering [9] or [0], results in a return to the Environment Menu or Main Menu, respectively (see
also Fig. 6.20).

— MAN MENU

'

EDIT MENU

'

A= ENVIRONNENT MENU

'

PERTURBATIONS MENU

|

# J,

DENSITY VARIATIONS WND MENU

Fig. 6.20 - The Perturbations Menu.

6.3.5.2. (Tabulated) atmosphere perturbations.

Selecting option 1, (Tabulated) atmosphere perturbations, gives the following question on the
screen:
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Percentage of density deviation, default = <default>
Input new value (Enter to proceed):

We can enter any value for the percentage. It must be noted that the density variation is
restricted to the tabulated atmospheres, i.e., Tabulated CIRA86 (Kourou), Mars Viking-1 and
the three Lellouch-Hunten models. During the simulation, the atmospheric pressure is not
affected by the density deviation, while the temperature is recomputed according to the Ideal
Gas Law.

6.3.5.3. Wind model.
Wind Menu

Choosing option 2 from the Perturbations Menu, Wind model, the currently selected wind
mode! is shown and the Wind Menu as shown below. However, when the Moon is the central
body it may be obvious that the definition of wind has no meaning due to the absence of an
atmosphere. In that case, an error message is printed on the screen. After accepting this
message by pressing [Enter], we return to the Perturbation Menu.

Starting from the Wind Menu, it is possible to fully define a wind model, as can be seen in Fig.
6.21. In this Figure, the complete menu structure is indicated. Any further discussion on the
wind model will be based on this Figure.

Coming back to the Wind Menu, we see three options related to the definition of wind. The
default options [9] and [0], result, as usual, into a return to the previous (i.e., the Perturbations
Menu) and the Main Menu, respectively.

Option 1, No wind, will exclude any wind definition from the simulation. It will not erase any
defined wind mode! in memory, so when later on the user decides to edit the wind model again,
the data are still intact. But, these data are not written to any input file as long as this option
has been selected. After pressing [1], we return to the Perturbations Menu.
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Fig. 6.21 - The menu structure related to the wind data (continued overleaf).
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Simplified wind model

The second option from the Wind Menu, Simplified wind model, will select a zonal steady
state wind, based on the rotational rate of the planet. The wind is given by the following -
equation:

A(ch
vV, = W.p I COSD 6.1
W~ 300 (61)

with

Awg, = percentage of rotational rate

o, = planetary rotational rate (rad/s)
r = distance to CoM of central body (m)
o = planetocentric latitude (rad)

The user is asked to specify Awy,; this can in principle be any value. Depending on the sign

of Awg, is the direction of the wind. For a positive value, the wind is directed paralle! to the
equator in eastern direction (heading 90°). A negative value results in a zonal wind positive in
western direction (heading 270°). After entering the value for Awgy, the user returns to the Wind
Menu.

User-defined wind model

Option 3 from the Wind Menu, User-defined wind model, results in a new menu, as is
indicated below. We will call this menu the User-Wind Menu. The menu has 7 entries, apart
from the options [9] (return to the Wind Menu) and [0] (return to the Main Menu). Options 4,
Edit wind shear and 5, Edit turbulence, have not been implemented yet. They are part of
future extensions. We will now concentrate on the remaining options.
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1) Load and save wind database

Choosing option 1, Load wind database, or option 7, Save wind database, gives the name
of the currently defined wind database, and the standard File Menu, as indicated below.

The wind-database filename can be 'WIND.DAT" (program default) or the last user-specified
name.

Loading or saving the wind database is done in the same way as the aerodynamic database
(Section 6.2.5.2) or the parachute database (Section 6.2.6.2). Again, we will briefly repeat the
procedure. We begin with loading a database (nota bene: the database consists of all wind-
related data, which can be edited starting from the Wind Menu).

We can either accept the default database name by entering [1] or change the name by
entering [2]. Entering a 'blank’ name (option 2) also implies the use of the default filename.
When the indicated database is not found, an error message is given. We can enter another
filename (option 2) or decide to leave the File Menu (options 9 and 0). Also an I/O-error during
the read process results in an error message and a return to the File Menu. The wind data,
which may have been distorted by the /O error are reset to the default values. This means that
no wind is assumed.

By choosing option 9, we can go up one level in the menu structure (User-Wind Menu).
Entering [0] results in a return to the top level of the menu structure, the Main Menu. When the
wind database has been successfully loaded, the User-Wind Menu appears on the screen.

While saving a wind database, we specify the filename in exactly the same way as mentioned
above. Once a valid name has been entered, a check is made whether the given database
already exists. A warning is given if this is true, and the user can decide to overwrite the
existing file or to return to the File Menu, to change the filename. When the database has been
successfully saved, control is returned to the User-Wind Menu. An /O error during the write
process results in aborting the process and a return to the File Menu. An error during the write
process will not affect the data stored in memory.

2) Edit steady-state wind

Choosing option 2 from the User-Wind Menu, Edit steady-state wind, gives the currently
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selected steady-state wind and the following Steady-State Menu, with three options to choose
from. The first option, No steady-state wind, deselects the steady-state wind and we return
to the User-Wind Menu. During the simulation, this type of wind is not taken into account (nota
bene: when a steady-state wind has been defined, but later on the user decides to select No
wind from the Wind Menu, the latter selection overrules any definition of wind components; no
wind will be simulated).

There are two ways of defining the steady-state wind, either with magnitude/direction
components (option 2), or with zonal/meridional components. Both ways of entering a steady-
state wind are very similar, so we will describe the magnitude/direction components in detalil,
and restrict to some remarks in case of the zonal/meridional components.

Option 2 of the Steady-State Menu, Magnitude / direction components, gives again a sub-
menu. Either the magnitude (or the wind velocity) can be edited, or the direction (the wind
heading).

Selecting either of the two components, gives an overview of the related parameters of that
particular wind component (see also Fig. 6.22). Firstly, the heading of the component is indi-
cated. Since we are dealing here with a user-specified heading, no heading is indicated ('---).
When we come to discuss the zonal and meridional components, there will be a heading indica-
tion. Secondly, the so-called table variables are shown. Both components can be a function of
0, 1 or 2 table variables (or independent variables), as we have also seen with the aerodynamic
coefficients (see Section 6.2.5.3). These table variables are valid for both components.
Successively, the number of table variables, the actual table variables and the corresponding
number of entries are shown. Thirdly (and finally), a menu is printed. We will call this menu the
Component Menu.
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Fig. 6.22 - Overview screen for a wind component.

The Component Menu has three entries. Entering [9] or [0] results in a return to the previous
menu (for the menu structure, the user is once again referred to Fig. 6.21) or Main Menu,
respectively. Entry [1], Change any parameter, gives the user full access to the wind data.

We already mentioned that the table variables are valid for both components. Therefore, the
user is first asked whether he wants to edit the table variables. Answering [N] skips this part,
and we directly continue with editing the actual component. Answering [Y], the number of table
variables is printed (0, 1 or 2). When we enter [0], this means that the wind component has a
constant value. The user is asked to enter this constant value, and the overview screen is
printed again. Entering either [1] or [2], gives a list with possible table variables on the screen,
together with the selection of the first table variable. Nota bene: variable 2, In(pressure), means
the natural logarithm of the atmospheric pressure. After choosing the variable, by typing the
integer value of the variable - apart from [0], which has been added to show any possible
default setting - the second variable has to be selected (if any!).
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After selecting the table variable(s), the number of entries per table variable must be specified.
This can be any number from 1 to 40. Entering a number outside this range, gives an error
message on the screen. Accepting this message by pressing [Enter], a new number has to be
entered. Then, the actual entries of the table variable(s) have to be entered. Finishing the last
entry, we come to the entries for the wind component. For each entry, the combination of table
variables (their values) is printed on the screen, so that the user can see which entry he is
editing. When the last entry has been edited, the overview screen is printed again. Nota bene:
the velocity component has to be entered in meters per second, while the heading has to be
specified in degrees (0° is a northern wind, 90° eastern, 180° southern and 270° western; of
course any heading between 0° and 360° can be entered).

Entering option 2, Zonal / meridional components, from the Steady-State Menu can result in
two possible menus, depending on the selected central body. For the Earth and Mars, the
following menu is printed on the screen. :

Editing either of the two components is done in exactly the same way as has been described
above, with only one exception. In this case, the heading of the component must be explicitly
specified. Starting from the overview screen (Fig. 6.22), we select option 1, Change any
parameter. Before we arrive at the edit procedure as described above, the possible headings
for the particular component are shown on the screen, together with the question to input a new
value (or accepting the default value by pressing [Enter)).

For the zonal component, we can specify either a wind from west to east, or vice versa, as
indicated below (W-E is the default setting). A wind from west to east means, that a positive
wind is blowing in that direction. If a wind component is negative, then the wind is blowing from
east to west, for this setting. It may be obvious, that when a user has specified positive
components only, he can invert the direction of the wind by simply changing the heading. Any
heading must be entered, by typing the heading number ([1] or [2] for the zonal component).



Date: July 1993

Organization: TUD/LR/A2R
Page: 63

Document code: LR-726

For the meridional component, we have two different headings as well, as can be seen below.
The default setting for this component is a wind from south to north (S-N). The heading must

now be entered by typing [3] or [4].

in case the selected central body is Titan, we get a slightly different menu on the screen. We
can see an additional menu entry (entry 1). For Titan, it assumed that there is only a (strong)
zonal component. In Mooij (1992), a simplified engineering model for the zonal wind has been
described. This model is given by the following analytical formula: '

|Ves-Ves,s| < vss’max{1 +%ln{p_;£]]cos5 (6.2)

with
Ves = steady-state wind velocity (m/s)
Vess = Steady state wind velocity at surface, with |Ug| < 2 m/s
Vs max = Maximum steady state wind velocity = 200 m/s
P, = reference pressure = 50 N/m? (0.5 mbar)
p = atmospheric pressure (N/m?)
) = planetocentric latitude (rad)

This steady state model is referred to as the Flasar model.
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After selecting this option from the above menu, the user must specify the related parameters
for this model. Although the model knows fixed parameters, these have been made variable to
enable the user to study the uncertainty of this model. The following entries are successively
shown on the screen:

Surface speed (nom. 2 m/s), default 0.2000000000D+01

Input new value (Enter to proceed) :

Maximum windspeed (nom. 200 m/s), default 0.2000000000D+03

Input new value (Enter to proceed) :

0.5000000000D+02

Reference pressure (nom. 50 N/m**2), default
Input new value (Enter to proceed):

Furthermore, the following question should be answered:

Full evaluation <Y/N>, default N

A full evaluation (entering [Y]) means, that Eq. (6.2) is used to compute the wind velocity for
any height. The alternative is no full evaluation (answer [N]), meaning that up to the reference
altitude (for an atmospheric pressure of 50 N/m?, this altitude is about 220 km) the Flasar model
is valid and above the reference altitude the wind is assumed to be constant (= 200 m/s). The
direction of the wind is, for a positive Uy, in eastern direction.

After answering the last question, the user returns to the Zonal / Meridional Menu.

3) Edit wind gust

Choosing option 3, Edit wind gust, from the User-Wind Menu, the following menu appears on
the screen. Entering [1], No wind gust, excludes the wind gust from the simulation and we
return to the User-Wind Menu. By entering [2], Edit horizontal wind gust, the user can edit
this type of gust. The vertical wind gust has not been implemented yet, as is indicated by an
asterix in the menu.

For the horizontal wind gust we consider two types, as is depicted in Fig. 6.23. These two types
are designated as the 3t- and the 6t-type. Particular parameters, which must be known for these
wind gusts are:
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. hhg = initial altitude for horizontal gust (m)
. thg = thickness of horizontal gust (m)
hgmax = maximum velocity for horizontal gust (m/s)
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Fig. 6.23 - Horizontal wind gust models: (a) 3t-model and (b) 6tmodel.

The first question the user is asked, is the number of wind gusts. This number can be any
integer value in the range from 0 to 10. When zero is entered, one directly returns to the User-
wind Menu. For any other number, per wind gust the following parameters must be entered.
To start with, the shape of the gust. As we saw in Fig. 6.23, two shapes have been predefined.
The following menu shows these shapes, and the user has to enter the (integer) shape number
(either 1 or 2). Nota bene: the number of the horizontal gust, which is currently being edited,
is shown above this menu.

After the shape number, the following four parameters can be edited (the default variables,
which have been used, serve as an example; they may be different in an actual editing
session):
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Initial altitude (m), default 0.9000000000D+05

Input new value (Enter to proceed) :

0.6000000000D+02

Gust thickness (m), default
Input new value (Enter to proceed):

0.6000000000D+01

i

Maximum wind velocity (m/s), default
Input new value (Enter to proceed):

0.9000000000D+02

Heading for wind vector (deg), default
Input new value (Enter to proceed) :

After the last parameter, we start with the shape number of the next horizontal gust (if any).
When the heading for the wind vector of the last gust has been edited, control is returned to
the User-Wind Menu.

4) Extrapolation method

Option 6 of the User-Wind Menu, Extrapolation method, gives access to the Extrapolation
Menu, as is shown below. We already saw this menu, when we were discussing the aerodyna-
mic coefficients of both the entry vehicle (Section 6.2.5.5) and the parachute system (Section
6.2.6.4). The description given there fully applies in this case; the user is referred to Section
6.2.5.5 for more information.

6.4. Mission aspects.
6.4.1. The Mission Menu.

Choosing option 3, Mission, from the Edit Menu, gives the Mission Menu on the screen, as
shown below.
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Fig. 6.24 - The Miss

ion Menu.

An asterix in the menu, means that these options have not been implemented yet (future
extensions). Entering [1}, [2], [3] or [4] enables us to enter and/or change mission-related input
data. These menu entries will be discussed in the next three Sections. We can leave the
Mission Menu in two ways, by entering either [9] or [0]. Fig. 6.24 shows us the relation between

the several menus.
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6.4.2. Initial state.

In order to start a simulation, we must provide START with the initial condition of the entry
vehicle. By entering [1] from the Mission Menu, Initial state, the following Initial State Menu is .
printed on the screen.

The initial conditions, which one has to provide, are depending on the kind of simulation he
wants to perform. In the 3-dof simulation, the re-entry vehicle is considered to be a mass point.
Only translations can be analyzed. In principle, we can restrict the initial conditions to position
and velocity. However, it is possible to define a constant attitude of the re-entry vehicle, so we
must always be sure, whether the proper attitude has been defined.

W.r.t. the aerodynamic forces, the attitude angles are used as follows: the angle of attack o
(used for a constant-lift entry)7, the angle of sideslip B (comparable with a, but in this case
resulting in a side force) and the bank angle o (for out-of-plane manoeuvres by tilting the lift
force). When thrust operations are being performed, the angles are also of importance, because
they (partly) define the orientation of the thrust vector w.r.t. the velocity. To understand the
influence of these angles, the interested reader is referred to the equations of motion, presented
in the technical documentation (e.g., Mooij (1993a)).

We can leave the Initial-State Menu, by entering [9] or [0], to return to the Edit Menu and the
Main Menu, respectively. The layout of the related menu structure is shown in Fig. 6.25.
Position and velocity

Choosing option 1, Position and velocity, from the Initial-State Menu, gives rise to three

possible ways of entering the initial state, as can be seen in the following menu. Besides, the
two standard entries [9] and [0] have been added (see also Fig. 6.25).

7 We have to specify a, when the aerodynamic force coefficients are defined as tables as a function of a.
in that case, the coefficients are computed for this (constant) a. If we have defined the force coefficients to be
constant, then a is already included in the value of the coefficients. In that case, o is not used to compute
aerodynamic forces. .
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Fig. 6.25 - The Initial-State Menu, with the corresponding Position-and-Velocity options.
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The equations of translational motion of START are based on spherical components, defined
w.r.t. the rotating planetocentric frame, index R (the origin coincides with the CoM of the central
body, the X-axis intersects the equator at zero longitude, the Z-axis is pointing in the same
direction as the rotation vector of the central body, and the Y-axis completes the right-handed
system). For a flexible input of position and velocity, cartesian components for the initial state
have been added. The third way of entering the initial state for position and velocity is by means
of the classical orbital elements. These elements are expressed w.rt. to the inertial
planetocentric frame, index .

Spherical elements

With spherical components, position and velocity (w.r.t. the A-frame) can be expressed by (Fig.
6.26):

Position: distance r, longitude t and latitude &
Velocity: groundspeed Vg flight-path angle yg and heading xg

The longitude is measured positively to the east (0° <1 < 360°). The latitude is measured along
the appropriate meridian starting at the equator, positively in north direction (0° <8 < 90°) and
negatively to the south. The distance r, finally, is the distance from the Centre of Mass (CoM)
of the central body to the CoM of the vehicle. The relative velocity V; (i.e., the modulus of the
velocity vector V) is expressed with respect to the R- frame. yg is the angle between Vand the
local horizontal plane; it ranges from -90° to +90° and is negative when V is below the local
horizon. x5 defines the direction of the projection of Vin the local horizontal plane with respect
to the local north and ranges from -180° to +180°. When y g = +90°, the vehicle is moving
paralle! to the equator to the east.

In order not to bother the user with the radius of the central body, r is not included as an initial
state variable. Instead, the height h is used. h is related to r by the following relation:

h =r - R,(1-esins) (6.3)
e

8 The inertial and rotating planetocentric-frame are coincident at t = 0.
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Fig. 6.26 - Definition of the six spherical flight parameters, the position (r,1,6) and
velocity (Vg YeXg)-

In this equation, R, is the equatorial radius of the central body and eis the elipticity. Numerical
values of these parameters have been discussed in Section 6.3.2.

Choosing the first option, Spherical elements (rotating planetocentric frame), gives rise to
the following set of questions:

Height h (m), default = 0.2201360000D+06
Input new value (Enter to proceed):

Longitude tau (degq), default = 0.2139590000D+03
Input new value (Enter to proceed):

Latitude delta (deg), default = 0.4311800000D+01
Input new value (Enter to proceed):

Velocity vector V (m/s), default 0.1100000000D+05

Input new value (Enter to proceed):

Flight-path angle gamma (deg), default -0.9563000000D+01

Input new value (Enter to proceed):

Heading chi (deq), default 0.5255600000D+02

Input new value (Enter to proceed):

Nota bene: as an example, we have given the default values of the input file, as shown in
Appendix A. These values can be different for other missions.

The range of allowable values for the above variables, are:
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th>0m
T :0°<1<360°

& :-90°< d<90°
Vg:Vg>0mis

Yg - -90° <Y< 90°
xg - 0° < xg < 360°

After having entered the value for the heading, we return to the Position/Velocity Menu.

Cartesian elements

Using cartesian components, the position and velocity with respect to the R-frame are defined
by the following variables (Fig. 6.27):

Position: x, y, z

Velocity: u, v, w

ZR‘

-

. xR

Fig. 6.27 - Definition of the cartesian position and velocity components.

Choosing the second option, Cartesian elements (rotating planetocentric frame), shows the
following set of questions on the screen:

x-position (m), default =
Input new value (Enter to proceed) :

y-position (m), default =
Input new value (Enter to proceed) :

z-position (m), default =
Input new value (Enter to proceed) :

x-velocity (m/s), default =
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Input new value (Enter to proceed):

y-velocity (m/s), default =
Input new value (Enter to proceed):

z-velocity (m/s), default =
Input new value (Enter to proceed):

Any value is valid for the above variables. However, it may be possible thata specified position
lies inside the central body. No checks w.r.t. this is executed; it is left to the user's responsibility
to enter a valid position.

After entering the z-velocity (i.e., w), the user returns to the Position/Velocity Menu.

Orbital elements

In case of an initial state defined by the classical orbital elements, we will restrict ourselves to
elliptical orbits. The six parameters, defining the position and velocity of a spacecraft in an
elliptical orbit are (see also Figs. 6.28 and 6.29):

e: the eccentricity (0 < e < 1)

a: the semi-major axis (a > Ry

i: the inclination (-180° < j < 180°)

w: argument of pericentre (0° < o < 360°)

Q: the longitude of the ascending node (0° < Q < 360°)
M: mean anomaly (0° < M < 360°)

For more details on the definition of these parameters, one is referred to Mooij (1993a).

SPACECRAFT

APOCENTRE ¢- PERICENTRE

Fig. 6.28 -  Definition of the semi-maijor axis a and the eccentricity e. The spacecraft is
moving at a distance r with a velocity V, w.r.t. to the inertial planetocentric
frame (index /. The true anomaly is indicated by 8.
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Fig. 6.29 - Definition of the three orbital parameters Q, ® and i The spacecraft is
moving at a distance r with a velocity V;w.r.t. to the inertial planetocentric
frame (index /. The true anomaly is indicated by 6.

The following questions have to be answered:

Eccentricity e (-), default =
Input new value (Enter to proceed) :

Semi-major axis (km), default =
Input new value (Enter to proceed):

Inclination i (deg), default =
Input new value (Enter to proceed) :

Argument of pericentre omega (deg)., default =
Input new value (Enter to proceed) :

Longitude of ascending node OMEGA (deg), default
Input new value (Enter to proceed) :

Mean anomaly M (degq), default
Input new value (Enter to proceed):

After entering the value for the mean anomaly, control is returned to the Position/Velocity Menu.

Attitude and angular rates

The attitude is expressed by aerodynamic angles, i.e., the angle of attack o5 (0° < a5 < 360°,
for a 'nose-up’ attitude ag < 180°)9, the angle of sideslip B (-180° < B < 180°, g is positive
for a 'nose-right’ attitude) and the bank angle o (0° < 0 < 360°), see also Fig. 6.30. Nota

9 This definition of a means, that a = 180°, the so-called 'zero-angle-of-attack’ corresponds with a ballistic
flight (for a symmetrical body). :
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bene: these angles define the attitude of the vehicle w.r.t. the groundspeed, at least when they
are used in the equations of motion. We will see in Section 8.2, that we can select an
alternative set of kinematic attitude equations based on quaternions. In that case, the initial
attitude is still based on the three aerodynamic angles.

The angular rate of the body is defined as the rotation of the body frame with respect to the

inertial frame, expressed in components along the body axes. The rotation vector o is defined
by the roll rate p, the pitch rate g and the yaw rate r (Fig. 6.31).

Choosing option 2, Attitude and angular rates, gives the following set of initial state data on
the screen. Again, we used default values as given in Appendix A.

Angle of attack alpha (deg), default 0.1569990000D+03

Input new value (Enter to proceed):

Angle of sideslip beta (deg), default = -0.8213830000D-03
Input new value (Enter to proceed):

Bank angle sigma (degq), default = 0.1100030000D+03
Input new value (Enter to proceed):

Angular roll rate p (deg/s), default = 0.1337782299D-01
Input new value (Enter to proceed):

Angular pitch rate g (deg/s), default = 0.1565778000D-01
Input new value (Enter to proceed):

Angular yaw rate r (deg/s), default = 0.4344631302D-01
Input new value (Enter to proceed):

The range for the above variables is:
ag:0°<ag<360°
Bg : 180° < Ps < 180°
O'G :0° < 0'G< 360°
P ]
q ] Any value.
rl

After we have entered the new value for r, we return to the Initial-State Menu.

Nota bene: any angle (or angular rate) must be entered in degrees (or degrees per second).
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Xac+ X16

Fig. 6.30 -  Definition of the aerodynamic attitude angles ag Bg and o5 The three
related reference frames are the body frame (index B), the (groundspeed-
based) aerodynamic frame (index AG) and the (groundspeed-based)

trajectory frame (index TG).

\°

Fig. 6.31 -  Definition of the angular rate of the vehicle, @ = (p,q.n7. The /- frame is
the inertial planetocentric frame, which has its origin in the CoM of the
central body. The origin of the body frame (index B) is located in the CoM
of the vehicle. The body frame is fixed to the body.
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6.4.3. Parachute operations.

Choosing option 2 from the Mission Menu, Parachute operations, is of course only meaningful
when at least one parachute system has been defined. Choosing this option, if the number of .
parachute systems is equal to zero, results in an error message. After accepting this message,
we return to the Mission Menu.

In case a parachute system has been defined, the user is asked to provide the number of the
parachute system, which is going to be used for the operations. If only one system has been
defined, it is obvious that this number must be one. Entering a number higher than the number
of defined parachute Systems is not possible.

Parachute operations are divided into three categories, namely deployment, reefing and release.
For parachute deployment, we need to specify the condition at which this occurs'?. A number
of criteria is possible. They will be printed on the screen successively, together with the default
setting. For each of these criteria, the user must specify, whether it is used ([Y] or [N]) and
when it is used, what the value of this criterium is. More than one criterium may be specified.
The criteria are:

» Flight time (in sec)

+ Height (in m)

+ Relative velocity (in m/s)

« Mach number (-)

- Dynamic pressure (in N/m?)
After the criterium of dynamic pressure, the user is asked, whether reefing will be applied at
parachute deployment. If [N] for No is answered, the program continues with parachute release.
We will discuss this later. First, we consider the situation that [Y] is answered, so the case that
parachute reefing is applied. In that case, the number of reefing intervals must be specified.
This may be any number between [1] and [5]. Per reefing interval, a number of data must be
entered. These are:

» the reefing time, i.e., the length of the reefing interval (in sec)

« total percentage of deployment at the end of the interval (0-100%)

10 Parachute deployment is, in principle, equal to a configuration change. Due to the specific nature of this
event, we discuss it separately. However, the way parachute deployment affects the mass properties of the re-
entry vehicle is the same as for configuration changes. Parachute deployment may have an influence on the
location of the CoM and on the moments and products of inertia. Besides, the mass of the re-entry vehicle will
change. Mass properties of the parachute system in packed condition (see also Section 6.2.6.2) are used to
update the mass properties of the re-entry vehicle.
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« Exponent for drag-coefficient development
« Exponent for parachute-area development

Nota bene: the percentage of deployment of reefing interval /i, can never be smaller than the
percentage of interval i-1. However, itcan be equal, which would mean that we have introduced
a stabilizing interval.

If the parachute is not going to be released, we must enter [N] on the question put on the
screen. In that case, entering data related with parachute operations has finished and we return
to the Mission Menu. On the other hand, answering [Y] gives need to specify the criterium (or
criteria) for parachute release. These criteria are the same as for parachute deployment, so

Flight time (in sec)

« Height (in m)

» Relative velocity (in m/s)

+ Mach number (-)

- Dynamic pressure (in N/m?)

Again, we must indicate which criterium is used ([Y] or [N]) and provide the numerical value if
it is used. After (de)selecting the dynamic pressure, we return to the Mission Menu.

6.4.4. Configuration changes.

As we described in Section 6.2.2, the entry vehicle can be modelled by means of a number of
mass elements. If the number of mass elements is greater than 1, it is possible to delete one
(or more, depending on the total number of mass elements) element, depending on a prede-
fined flight condition. In this way, we can simulate a configuration change of the entry vehicle,
e.g., the jettisoning of an aerodynamic shell.

We can define configuration changes by entering [3], Configuration changes, from the Mission
Menu. If only one mass element has been defined, an error message is given. After pressing
[Enter], we return to the Mission Menu. In that case we have to increase the number of mass
elements to at least 2, before we can define configuration changes.

Let us assume, that the number of mass elements is greater than one. In that case, after
selecting Configuration changes from the Mission Menu, we must specify the number of
configuration changes. This number can be 3 as a maximum, but cannot be higher than the
number of mass elements minus one (always at least one mass element should remain
defined). Per configuration change, a number of data must be entered.
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First, we must specify the mass element for the configuration change by entering its number.
Giving a number higher than the number of mass elements is rejected. If we input a number,
which has already been defined for a configuration change, an error message appears. This
message can be accepted by pressing [Enter], so that we can enter a new number.

‘Then, we must give the shift of the aerodynamic reference point with respect to which the
aerodynamic coefficients are defined, here indicated as Centre of Pressure (CoP). Both the dX-,
dY- and dZ-shift must be entered.

Apart from a shift of the aerodynamic reference point, also the reference geometry may change,
as well as the aerodynamic coefficients themselves. The next three data correspond with the
reference geometry, the aerodynamic reference length d and area S, and the reference length
for computation of the Reynolds number, L, (see also Section 6.2.4). Then, the user is asked
whether a new aerodynamic database, containing the aerodynamic coefficients, should be
linked at the configuration change (so that we can change the aerodynamic properties of the
re-entry vehicle). Answering [N] skips the next input, the one of entering the file name of the
database. If, after answering [Y], the specified database does not exist, a warning is given to
remind the user. The warning can be accepted by pressing [Enter]. Nota bene: if the database
is not found during the simulation, it is aborted.

Finally, the event for the configuration change must be entered. The same criteria, as discussed
before, apply. They are restated below:

+ Flight time (in sec)

Height (in m)

Relative velocity (in m/s) .

+ Mach number (-)

« Dynamic pressure (in N/mz)
We can (de)select one (or a combination) of the above criteria, by entering [Y] ([N]) for the

proper criterium. Having selected the criterium, we must also provide the numerical value of the
criterium.

After (de)selecting the dynamic pressure, we can either decide to edit the next configuration
change (if any) by entering [Y], or to return to the Mission Menu (entering [N]). After the last
configuration change, we automatically return to the Mission Menu.

6.4.5. Propulsion operations.

Choosing option 4, Propulsion operations, from the Mission Menu, gives the following sub-
menu on the screen. In principle, this menu was not necessary, because there is only one
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menu entry (Deorbit-burn manoeuvre). However, with respect to future extensions the menu has
already been implemented. The related menu structure is schematically shown in Fig. 6.32.

Entering [1] from the above Propulsion Operations Menu, Deorbit-burn manoeuvre, results
in the question whether the user wants to select the deorbit-burn manoeuvre or not. Answering
[N] results in a return to the Propuision Operations Menu. Giving [Y] as an answer, gives atable
with the three implementations, as can be seen below. The currently selected implementation
of the manoeuvre is printed below the table, and the user is asked to enter his choice, or to
accept the default choice by pressing [Enter].

The three deorbit-burn implementations can be divided into two essentially different methods.
The impulsive dV, is, as the name indicates, an instantaneous manoeuvre. No thrust is
included. The two other implementations, mfuel by Tsiolkovsky and mfuel specified are so-
called finite-thrust manoeuvres. The two methods will now be discussed below.
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—-T—-’ MAIN MENU

'

EDIT MENU

'

Lo MISSION MENU

'

#»-| PROPULSION OPERATIONS

L

DEORBIT-BURN
MANOEUVRE

I

' ' 1

IMPULSIVE DV MFUEL BY TIOLKOVSKY NFULL SPECIFIED

Fig. 6.32 - The menu structure for propulsion operations, including the deorbit-burn manoeuvre.

Impulsive dV

. The (inertial) AV-vector is vectorially added to the initial velocity of the spacecraft. AV is given
as a modulus and two direction angles, relative to the inertial velocity of the vehicle (Fig. 6.33).
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INERTIAL VELOCITY OF SPACECRAFT

AV EAV

TOWARDS CoM OF
CENTRAL BODY

IN-PLANE VIEW

INERTIAL VELOQITY OF SPACECRAFT

®

TOWARDS CoM OF
CENTRAL BODY

QUT-OF -PLANE VIEW

Fig. 6.33 - Definition of the AV-vector.

Finite thrust manoeuvre

Also in this case, the inertial AV-vector is given as a modulus and two (relative) direction
angles. The AV is now achieved by a thrusted manoeuvre. The direction of the thrust is
computed on basis of the (fixed) orientation in inertial space. So when the spacecratft is orbiting
the central body, the thrust direction is constantly adjusted, because the orientation of the body
frame (in which the thrust is defined) is continuously changing w.r.t. the inertial frame. As a stop
criterium for thrusting, the achieved (total) AV in thrust direction is taken. This implies, that we
assume a drag-free deorbit-burn manoeuvre, i.e., an exoatmospheric manoeuvre.

Choosing option 1, Impulsive dV, from the Deorbit-Burn Menu gives rise to three questions:

Delta V (> 0 m/s),

default =

Input new value (Enter to proceed):

The next two angles define the orientation of the dV vector.

In-plane angle (0, 360 deqg),

default

Input new value (Enter to proceed):

Out-of-plane angle (-90, +90 deg), default

il

Input new value (Enter to proceed):

The ranges of the two angles are:

0° < e,y < 360°
-90° <y, < 90°

After entering the out-of-plane angle v, we return to Propulsion Operations Menu.

By choosing option 2, mfuel by Tsiolkovsky, we select a finite-thrust manoeuvre. Naturally,
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such a manoeuvre can only be executed once the deorbit-burn engine has been selected. If not
so0, a warning is given:

Warning: no deorbit-burn engine specified!
Press Enter to continue.

After accepting the waming (or when the deorbit-engine was specified, and the warning was
not given), the same questions as mentioned above appear on the screen. During the
simulation, the fuel mass needed for the manoeuvre is computed using Tsiolkovsky's Equation:

AV
mg =My 1-e %o'sp (64)

with

m; = fuel mass

m, = mass of entry vehicle (k@)

AV = modulus of AV-vector (m/s)

lsp = specific impulse of deorbit-burn engine in vacuum (sec)
go = gravitational acceleration at sea level (m/s )

The thrusted manoeuvre will end when all the fuel has been used.
With option 3, mfuel specified, the user can specify the fuel mass himself. Again a check is
made, whether the deorbit-burn engine has been specified. Then, after a warning or not, first

the fuel mass has to be specified:

Fuel mass for deorbit burn (> 0 kg), default =
Input new value (Enter to proceed):

Then, the AV is specified in the same way as mentioned above, by specifying the modulus and
two direction angles. The thrusted manoeuvre will end, when (a) the fuel mass is zero, before
the AV has been achieved, or (b) the AV has been achieved (in thrust directionl).

After specifying the out-of-plane angle, we return to the Propulsion Operations Menu.

6.5. Simulation aspects.
6.5.1. The Simulation Menu.

Choosing option 4 from the Edit Menu, Simulation, enables us to edit simulation related
variables. The following menu, the so-called Simulation Menu, appears on the screen:
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The first five menu entries are related with simulation aspects, and will be discussed in the next
Sections. Entering [9] or [0], resuits in a return to the Edit Menu (the previous menu) or the
Main Menu. The related menu structure is shown in Fig. 6.34.

| DT MENU

SNULATION WEW)

NTEGRATION WETHOD MAXMUM STEP SZE QUTRT FILING RATE TOLERANCES STOP CRITERA

Fig. 6.34 - The Simulation Menu.

6.5.2. Integration method.

Entering [1] from the Simulation Menu, Integration method, gives the current selection of the
integration method on the screen, together with a menu with available integration methods.
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We can select one of the six integration methods by entering [1], [2], ... [6]. Itis recommended
to use the variable-step, seventh-order Runge-Kutta-Fehlberg method ([2]) for 6-dof simulations,
and the variable-step, variable-order Adams-Bashforth Adams-Moulton ([3]) for 3-dof simula-
tions.

Selecting an integrator will automatically adjust the maximum integration step size. For the
fixed-step fourth-order Runge-Kutta and the fixed-step Adams-Bashforth integration methods,
this maximum step corresponds with the fixed step size, and is equal to df= 0.01 s. For the two
variable-step integrators, the maximum step size is equal to dt,,, = 1 sec. After selecting an
integration method, we return to the Simulation Menu. We can leave the menu with [9] or [0]
as well.

6.5.3. Maximum integration step size.

Entering [2] from the Simulation Menu, Maximum integration step size, gives the current
value of the maximum integration step size dt,,,,. For the fixed step-size integrators, this
maximum step corresponds with the fixed step-size dt. We can enter a new value for df,.,,
accept the current value by pressing [Enter]. The value we enter, must be greater than zero,
of course. Hereafter, we return to the Simulation Menu.

6.5.4. Output filing rate.

Choosing option 3 from the Simulation Menu, enables us to edit the values for the output filing
rate. We must specify two output filing rates, i.e., the one for the quickiook data (data, which
are printed on the screen during the simulation, in order to monitor the computations; these data
are also written to a file) and the one for the plot data. Below, we have indicated what will
appear on the screen, using the default values of Appendix A. -

0.2000000000D+01

The quicklook data filing rate (s), default
Input new value (Enter to proceed):

The plot data filing rate (s), default 0.1000000000D+01

Input new value (Enter to proceed):

b W]
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It is obvious, that the filing rates must have values greater than zero. After specufymg the plot
filing rate, we return to the Simulation Menu.

6.5.5. Tolerances.
The variable-step integrators require tolerance values for the state variables, in order to be able

to compute the integration step size. We can specify these tolerances, by entering [3],
Tolerances, from the Simulation Menu. The tolerances, which we can edit, are, in successive

order:
+ Tolerance for velocity V (m/s)
« Tolerance for flight-path angle y (deg)
« Tolerance for heading x. (deg)
« Tolerance for position r (m)
« Tolerance for position angles t and & (dég)
« Tolerance for angular rates p, g and r (deg/s)
« Tolerance for attitude o, § and o (deg)
Ali tolerance values must be positive and unequal to zero.

Having entered the tolerance for the attitude angles, we return to the Simulation Menu. Nota
bene: when quaternions are used as state variables, the attitude tolerances are picked as
tolerances for the quaternions.

6.5.6. Stop criteria.

Simulation will continue unti! some pre-defined stop criterium has been met, or when we reach
the so-called internal stop criterium. This criterium is:

« reaching the surface of the central body (h =0 m)
The user-defined stop criteria can be defined by choosing option 5 from the Simulation Menu,

Stop criteria. We get a similar list, as discussed for parachute operations (Section 6.4.3) and
configuration changes (Section 6.4.4). For the sake of convenience, the possible criteria are

repeated below.

< Flight time (in sec)

T s e
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s oo o e

i 8 e v R o i

i e



Organization: TUD/LR/A2R . Date: July 1993
Document code: LR-726 Page: 87

Height (in m)

Relative velocity (in m/s)

Mach number (-)
. Dynamic pressure (in N/m?)
Again, we can (de)select each of the above criteria, by entering [Y] ([N]). When we have ﬁ

selected a criterium, we must also specify the corresponding numerical value. After
(de)selection of the dynamic pressure, we return to the Simulation Menu. =
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7. Save input data.

We can save the input data, by choosing the option Save input data from the Main Menu. In
that case, the default input filename and a File Menu, as shown below, appear on the screen. '
The default file name can be 'INPUT.DAT' (program default) or the last user specified name.

1

Ep
£4
£
5
5
b
&t

This File Menu has been discussed before, so we will just refer to Chapter 4. Having entered
a file name, which already exists, a message appears on the screen:

This file already exists. Overwrite <Y/N>?

Entering [N] results in a return to the File Menu, so that we can alter the file name. If any error
occurs during the write process, an error message is given. After accepting this message by
pressing [Enter], we return to the File Menu. '

The related menu structure is given in Fig. 7.1.

" MAIN MENU

#

FILE MENU
SAVE INPUT DATA

Fig. 7.1 - The File Menu for saving input data.
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8. Simulation.

8.1. Simulation Menu.

Entering [5] from the Main Menu, option Simulation, gives the settings of the selected simula-
tion parameters and the following menu on the screen. The simulation parameters consist of
the choice of the position and velocity variables, the choice of the kinematic attitude variables
and the simulation mode.

For the sake of convenience, we have given this menu the name Simulation Menu. However,
the user must not be mistaken with the Simulation Menu, which can be chosen from the Edit
Menu (Section 6.5.1).

We can leave this menu, by entering [9] or [0]. In both cases we return to the Main Menu. This
is visualized in Fig. 8.1. In the next two Sections, we will discuss the first two menu entries.



Organization: TUD/LR/A2R

. Date: July 1993

Document code: LR-726 Page: 90
— MAIN MENU
SIMULATION MENU
CHANGE ANY PARAMETER START SIMULATION
FLE MENY
QUICKLOOK AILE
FILE MENU
PLOT FILE
I
!
I
Fig. 8.1 -  The Simulation Menu, including the two file menus for editing the name of

the quicklook file and the plot file.

8.2. Change any parameter.

Choosing option 1 from the Simulation Menu, Change any parameter, enables the user to
change the simulation parameters. First, the default selection of the position and velocity
variables is shown, together with a list with possible options.
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For the time being, the cartesian variables have not been implemented yet, so only the
spherical components can be chosen. :

Then, the next screen appears: the selected kinematic attitude variables plus a list with options. .
The choice of the variables has to be entered as an integer value.

The last simulation parameter concerns the simulation mode. The default selection and the two
possible options are shown on the screen.

Nota bene: if parachute operations have been defined, we must in principal select 6 dof simula-
tion, because we need all the twelve state variables to compute initial conditions for the para-
chute phase (the parachute model is a 6-dof one). However, when we select 3 dof simulation,
we must provide initial conditions for all twelve state variables, so also attitude and angular
rates. To compute initial conditions for the parachute phase, these values will be used in that
case. For a 3-dof entry without parachute operations, the three aerodynamic angles appear in
the equations of translational motion. These variables are constant, of course, with values the
same as the initial conditions for these angles.

After selecting the simulation mode, we return to the Simulation Menu.

8.3. Start simulation.

Choosing option 2, Start simulation, from the Simulation Menu, does not immediately result
in executing the simulation. First, some internal checks are made, whether the input data are
correct to perform a simulation (check on the existence of the inverse of the inertia tensor in
case of a 6 dof simulation; if it does not exist, an error message is given, resulting in a return
to the Main Menu). Then, the user must specify the name of the quicklook file and the plot file.

For this reason, the default name of the quicklook file, 'OUTPUT.DAT", is shown on the screen,
together with a File Menu, as shown below.
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This kind of file menu is used throughout the program and has been discussed several times
before. The user is referred to Chapter 4 or Section 6.2.5.1.

If the selected file already exists, a message is given. The user can decide to overwrite the file
(answering [Y] on the question Overwrite?), or return to the File Menu (answering [N]), to
change the file name. At any time, the user can return to the previous menu or Main Menu.

Once we have specified the quicklook file, the default name of the plot file appears on the
screen, together with a similar menu, as shown above. The same discussion applies. For an
overview of the related menus, one is referred to Fig. 8.1.

After specifying the plot file name, the actual simulation begins and continues until a stop
criterium is met. In that case, control is returned to the Main Menu.

Nota bene: just before the simulation begins, a copy of the current input data is written to the
file "xxxxxxxx'. During the simulation, some of the input data may be changed (think of loading
an aerodynamic database). In order to keep the original set intact, they are read again after the
simulation has finished.
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9. Output of START.

The output of START can be divided into two categories. The first category deals with the
quicklook data. During the simulation, the most important variables are printed on the screen’
at a user-defined rate (Section 6.5.4), so that the user can monitor the simulation. If any
numerical instability occurs, it will be shown in the variables and the user can abort simulation.
These quicklook data are also written to a user-specified file (for an example of the quicklook
data, one is referred to Appendix B). In this file, also the complete set of input data, used for
that particular simulation, can be found.

If a special event occurs during the simulation, i.e., parachute deployment, parachute release
or a configuration change, a message is sent both to the screen and the quicklook file. In this
way, it is easy to trace back the conditions at which these events actually occurred.

The second category deals with the plot data. Plot data are written to a user specified file, in
a specific format. The same format must be used to write a conversion program, in order to
convert the plot file to a file, which can be processed by a plotting software package. The plot
data can be divided into three categories, namely the ones for the (re-)entry vehicle (index 1),
the parachute (index p) and the complete system (no index). They are written in the order as
shown in the table below (index g means groundspeed based and index a airspeed based).

Nota bene

The simulation model for the entry vehicle alone and the parachute/payload system are two
separate models. The former is based on spherical position and velocity components and the
latter on cartesian ones. When the entry phase is considered, only the first 51 variables have
a meaningful value. The other output variables are put to zero. Once the ‘parachute mode''!
has been entered, all 98 variables have a meaningful value. However, this does not apply to
the variables indicated with a superscript **'; these variables cannot be accessed for the time
being.

The output variables:

1) t elapsed simulation time (flight time)

2) o latitude °
3) 1 longitude i
4) h height km
5) Vg', relative groundspeed of entry vehicle m/s
6) Yg.r flight-path angle (groundspeed) of entry vehicle °
7 Xgr heading (groundspeed) of entry vehicle v °

1 with the ‘parachute mode’, we mean that the dynamical model representing the parachute system is used
to integrate the equations of motion. After jettisoning of the parachute, this model is still used for computing the
motion of the entry vehicle alone (and all 98 variables are being used for output). Part of future extensions is the
implementation of cartesian position and velocity components for the entry phase, including full access of all plot
variables. .



Organization: TUD/LR/A2R

Date: July 1993

Document code: LR-726 Page: 94
8 p angular roll rate of system with respect to the inertial frame

(expressed in components along the body axes) °fs
9) gq angular pitch rate of system with respect to the inertial frame

(expressed in components along the body axes) °ls .
10) r angular yaw rate of system with respect to the inertial frame

(expressed in components along the body axes) °/s
11) g, angle of attack (groundspeed) of entry vehicle °
12) Bg, angle of sideslip (groundspeed) of entry vehicle °
13) oy, bank angle (groundspeed) of entry vehicle °
14) or, total angle of attack (groundspeed) of entry vehicle °
15) La,, lift force (airspeed) acting on entry vehicle N
16) D,, drag force (airspeed) acting on entry vehicle N
17) S,/ side force (airspeed) acting on entry vehicle N
18) LD, lift-to-drag ratio (airspeed) for entry vehicle -
19) Fg 1) first component of gravity force acting on entry vehicle, i.e.,

gravitational force along position vector for spherical compo-

nents and the cartesian component in X-direction (in case of the

3D-parachute model) N
20) FG',(Z) second component of gravity force acting on entry vehicle,

i.e., zero for spherical components N
21) Fg (3) “third component of gravity force acting on entry vehicle,

i.e., the gravitational force along the meridian for spherical

components ' N
22) L, roll moment acting on entry vehicle Nm
23) M, pitch moment acting on entry vehicle Nm
24) N, yaw moment acting on entry vehicle Nm
25) Qayn,r dynamic pressure for entry vehicle N/m?
26) M, Mach number of entry vehicle -
27) Re, Reynolds number for entry vehicle -
28) g_load occurring dimensionless deceleration (deceleration/g,) for entry

vehicle -
29) p atmospheric pressure N/m?
30) p atmospheric density kg/m?3
31) Tuin kinetic temperature K
32) a speed of sound m/s
33) ¢ roll angle for system °
34) 6 pitch angle for system °
35) vy yaw angle for system °
36) dt time step for integration s
37) Va,, relative airspeed of entry vehicle m/s
38) Yar flight-path angle (airspeed) of entry vehicle °
39) Xar heading (airspeed) of entry vehicle °
40) o, angle of attack (airspeed) of entry vehicle °
41) B, angle of sideslip (airspeed) of entry vehicle °
42) o bank angle (airspeed) of entry vehicle °
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43) ar,, total angle of attack (airspeed) of entry vehicle °
44) Gyr time derivative of o (airspeed) for entry vehicle °
45)° Ba', time derivative of p (airspeed) for entry vehicle
46): Lg’, lift force (groundspeed) acting on entry vehicle N
47)' Dg,, drag force (groundspeed) acting on entry vehicle N
48) Sg', side force (groundspeed) acting on entry vehicle N
49) V,, wind velocity (modulus) m/s
50) v, flight-path angle of wind vector °
51) %, heading of wind vector °
52) Vg,p relative groundspeed of parachute m/s
53) Yg.p flight-path angle (groundspeed) of parachute °
54) Xg,p heading (groundspeed) of parachute °
55) Qgp angle of attack (groundspeed) of parachute °
56) Bg’p angle of sideslip (groundspeed) of parachute °
57) or ., total angle of attack (groundspeed) of parachute °
58) La'p lift force (airspeed) acting on parachute N
59) Da'p drag force (airspeed) acting on parachute N
60) Sa,p side force (airspeed) acting on parachute N
61) Fg (1) first cartesian component of gravity force acting on parachute N
62) FG,p(Z) second cartesian component of gravity force acting on

parachute N
63) FG'p(3) third cartesian component of gravity force acting on para-

chute N
64) Lp roll moment acting on parachute Nm
65) Mp pitch moment acting on parachute Nm
66) Np yaw moment acting on parachute Nm
67) Quynp dynamic pressure for parachute N/m?
68) Mp Mach number of parachute -
69) Re, Reynolds number for parachute -
70) g Ioadp occurring dimensionless deceleration (deceleration/g,) for para-

chute -
71) Vap relative airspeed of parachute m/s
72) Yap flight-path angle (airspeed) of parachute °
73) Xap heading (airspeed) of parachute °
74) oy, angle of attack (airspeed) of parachute °
75) Ba'p angle of sideslip (airspeed) of parachute °
76) or,, total angle of attack (airspeed) of parachute °
77)' Gap time derivative of a (airspeed) for parachute °
78)' ﬁa‘p time derivative of B (airspeed) for parachute °
79) S, parachute area m?
80) Iy first moment of inertia for system kg m?
81) |/ second moment of inertia for system kg m?
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82) |/, third moment of inertia for system kg m?
83) m, added mass ‘ kg
84) u cartesian u-velocity for system m/s
85) v cartesian v-velocity for system m/s -
86) w cartesian w-velocity for system m/s
87) x cartesian x-position for system m
88) y cartesian y-position for system m
89) 2z cartesian z-position for system m
90) M, , swivel moment around X-axis Nm
91) M, , moment around X-axis due to spin vanes Nm
92) ag, angle of attack for spin vanes °
93) B, angle of sideslip for spin vanes °
94) Orgy total angle of attack for spin vanes °
95) Cp o lift coefficient for spin vanes -
96) CD'SV drag coefficient for spin vanes -
97) Cxsev axial force coefficient for spin vanes -
98) CZ,sv normal force coefficient for spin vanes -

The format, in which the 98 variables are written to the plot file, is:

24(4918.6,/),2g18.6
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10. Quit the program.

Selecting option 6, Quit the program, from the Main Menu aborts execution of START. A clos-
ing screen is shown and control is returned to the operating system. Nota bene: no warning is '
given whether one really wants to stop the execution of START. This is left to the users own
responsibility.



Organization: TUD/LR/A2R ) Date: July 1993
Document code: LR-726 Page: 98

References.

1)

2)

3)

4)

5)

6)

7)

Mooij, E.;

Development of START, a six degrees of freedom Simulation Tool for Atmospheric Re-
entry Trajectories; '

ESTEC Working Paper EWP 1633,

ESTEC, Noordwijk, 1991a.

Mooij, E.;

ESA Huygens probe entry trajectory analysis;
ESTEC Working Paper EWP 1634,

ESTEC, Noordwijk, 1991b.

Mooij, E.;

START User Manual, Version 1.0;

Thesis report Delft University of Technology, Faculty of Aerospace Engineering;
Delft, 1991c.

Mooij, E.;

Source listing of START, Version 1.0. Appendix to the User Manual;

Thesis report Delft University of Technology, Faculty of Aerospace Engineering; Delft,
1991d.

Mooij, E.;

ESA Huygens probe entry and descent analysis;
ESTEC Working Paper EWP 1679;

ESTEC, Noordwijk, 1992.

Mooij, E.;

The influence of the deorbit burn on the footprint of a re-entry capsule;

Report LR-727;

Delft University of Technology, Faculty of Aerospace Engineering, Delft, 1993a.

Mooij, E.;

Source listing of START, Version 2.1. Appendix to the User Manual;

Report LR-726;

Delft University of Technology, Faculty of Aerospace Engineering, Delft, 1993b.



Report LR-726 Appendix A - Example of input file

July 1993 Ir. E. Mooijj
: aculty of Aerospace Engineering

U Delft

Delft Unirsity of Technology



Date: July 1993

Organization: TUD/LR/A2R
Page: -

Document code: LR-726

This page has been intentionally left blank



00+d0000000008°0
00+00000000006°0
00+0d00000000S6°0
00+d0000000056°0
T0+0000000000T°0
10+00000000S0T"0
T0+000000000TT"0
10+J000000000T°0
10+3000000000T°0
00+00000000008°0
00+0000000000L°0

£€0+00000000081°0
€0+000000000LT°0
€0+00000000091°0
€0+G00000000GT"0
€0+000000000%T°0

j03®@ = ¢

10+300000000VE"0
10+d000000000€E°0
10+0d0000000092°0
10+0000000000Z2°0
10+000000006ST°0
10+d0000000GET"0
10+30000000021°0
10+0000000001T°0
00+030000000006°0
00+0000000000L°0

01

yseW = ¢

(z ‘1)
(1 ‘01)2
(1 ‘6 )2
(T ‘8 )2
(1 ‘¢ )d
(1 ‘9D
(1 ‘s )2
(1 ‘% )0
(1 ‘€ 1D
(1 ‘¢ )>
(T ‘T 12

jusuodwod JUSTOTIIL0D I0J San[ea uoTIdUNG

Kijug
K1qug
K13ug
Kajug
Kajug

— N M s n

Z# 919ETIEA BTQP3 I0J SBTIUS JO ITaqunN

z4 eTqeTIEA B1qEL

Kijug
Kaqug
Kajug
K1juzg
Kai3ug
K13jus
Aijug
Kajug
K13ug
Kajug

—

- ONM T~ O

14 ®iqeriea ayqe3 Joj salIjua jo JaqunN

14 @1qeTiea afqel

ssTqeTiea a[qel jJO JaqunN

UOTIBATISP JO I9PI0

14 3jusuodwod JUITOTIFSO0D 103 €IPQ <xxxxxsxwxx

squauodwod JUSTOTIIL0D JO I3aqunN

10+d000000006€°0

20+0000000002T°0

T0+d000000006€°0

00+00000000000°0
r0+d0b86661SLT O
00+00000000000°0
y0+d09LT08bSPY O
r0+d9S0€29bSkb°0
y0+d96¥S09LT9S°0

00+00000000LET"O
00+G0000000000°0
10+d0000000LSC "0~

ry0+d0000009L6¥%°0

EXNENRANRRXXNENNEA RSN EX XX ANERX
xx do ILNJIDIAJd0D ¥
NEARNNNAREXARRRNNNRERRKEXX NN AXY

poyzsw uotiejodealxy

Apog otajsuwwAsixe ST a[oTyaa Aijus-ay

AFRFRNARRERRERENNAR NS RN RN NN
»x SOIWYNAQOYAV xx

NXERXANEXAXNBRNA AR RREXARANERX

Jaqunu-ay J03 (w) 3Fail yibual -3ay
-3Jjo00 -polae 103 (Z.,W) § ©dIE "3I3Y
-j3@0o -poise 103 (W) p y3lbual 3oy

EANNNFFRRXRRRANEREE XY XX RRARERN
»x AY13dnodao - Jdd %
XXRERNNRARRANAXNERE R R AN RN RN NN

(2 u bx) zA1
(g w bY) zx1
(zou By) AxI
(zow BbY) zz21
(z.,w bx) K471
(Zow B) xxI

(W) HWOD 23'UTPI0COD-7
(W) WOD @31'UTIPICOD-X
(u) WOO @3'PUTPIOCOD-X

(6%) yooda e ssey

T # JUSWIT[9 SSPW JOJ PIP( <yxrxxxxxxy

S]UBWATD® ssew JO IJIaquny

AAENERARXNNERNERERERELRRNNNERY
xx SAILUTd0OEd SSYW »»

AERBENXXERRERNNNR SRR R RN R RRALANS

v :ebed
a6l AInr teleq

9¢/-41 :epod uswndog
"zv/dvanl :uoneziuebio



00+000000000bb "0 (z ‘2D 1 squauodwod UaIOTIF20D JO IaqUNN
00+3000000000% "0 (z '1 )2
00+Q000000002S°0 (T ‘0T)D AENNNRNNKNRRRERNRN N NN N ERRAA NN
00+00000000025°0 (1 ‘6 )D xx 10 INJIDIALI0D xx
00+@000000002S°0 (T ‘8 )2 ANRNNRNNRR LR RN RNN AR XA R R A RN
00+d0000000095°0 (1 ‘L )d
00+00000000009°0 (T ‘912
00+Q00000000%9°0 (1 6 ) T0+00000000SkT"0 (s ‘0T)2
00+000000000¥9°0 (T ‘v )0 © 10+00000000SHT°0 (6 ‘6 )D
00+0300000000%¥9°0 (1 ‘'€ 1D 10+Q00000000ST°0 (6 ‘8 D
00+d00000000¥S°0 (1t ‘¢ 1D 10+Q0000000SFT°0 (6 ‘L )D
00+0000000002S°0 (1 ‘13D 10+d0000000621°0 (¢ 912
10+000000000FT°0 (6 ‘S 1D
jusuodwod JUSTOTIJB0D I0] SBNTRA UOTIdUNY 10+000000000€T°0 (6 ‘% 1D
10+G00000000€ET 0 (6 ‘€ ID
€0+d000000008T°0. ¢ 4Ax3jugz : 10+000000000TT°0 (g ‘2>
£0+000000000LT 0 p Aaajug 10+0000000000T°0 (¢ ‘11D
€0+3000000009T°0 g€ Ax3uz 10+000000000%T°0 (¢ ‘0T)D
€0+0d000000006T°0 ¢z 4ajuz 10+d0000000SkT 0 (v ‘6 1D
£0+300000000FT°0 1 Aa1jug 10+00000000S%T°0 (y ‘8 )0
10+00000000S¥T°0 (b ‘L )2
S Z# @1qeriea a[qel 103 S3TI3jud jO Idquny T0+d000000062T°0 (v ‘9 )0
’ 10+000000000% 1" 0 (¢ ‘51D
j03e = ¢ Z# @1qetIea aTqel 10+000000000€T"°0 (v ‘v 1D
10+000000000€ET"0 (v ‘€ 1D
10+000000000Y€°0 01 Kajuz ’ 10+000000000TT"0 (v ‘21O
T0+3000000000€°0 6 Aajud 10+0000000000T°0 (y ‘T 1D
10+00000000092°0 g Aaaug 10+0d00000000€T°0 (¢ ‘01)D
10+0000000000Z°0 t 4&ajuaz . 10+000000000€T°0 (€ ‘6 )2
10+d00000006ST1°0 9 Ax3jug 10+Q0000000SET"0 (¢ '8 1D
10+00000000SET"0C ¢ Aajuz 10+3d00000000%T°0 (¢ ‘L )D
10+3d0000000021°0 vy Az3ug 10+300000000€T°0 (€ ‘9 )2
10+000000000TT"0C ¢ Aajuz 10+d0000000SET"0 (€ ‘S )2
00+4Q0000000006°0 Zz Axaug 10+Q000000062T°0 (¢ ‘v 1D
00+0000000000L°0 1 Az3juz 10+d0000000621°0 (€ ‘€ )2
10+0000000050T° 0 (€ ‘2D
0t T4 @(qeraea afqel I0J S§ITIJU3 JO IaqunN 00+Q0000000066°0 (¢ ‘T 1D
10+d00000000TT°0 (z ‘0T)D
yoeyw = G 1# @1qet1ien 27qe] T0+G0000000STT 0 (Z '6 1D
10+00000000STT°0 (Z ‘8 )2
[4 safqeTIeA 3[qP3 JO IdqUON 10+30000000021°0 (zZ ‘L 1D
10+d000000002T°0 (zZ ‘9 )2
0 UOTJIPATISD JO T3P0 10+0000000062T°0 (Z 's 1D
10+d000000001T°0 (z ‘v )2
1# 3Juauocdwod 3JUBTDTIJB0D JOJ BIPQ <xxxxxxxrxy 10+d0000000STT"0 (Z ‘e >
00+d0000000006°0 (z ‘2o
2y :ebed 92/-Y7 :9p02 Wewnd0Qq

€664 AInr teleq "zZv/dvanl :uoneziuebio



00+00000000000°0
10-@000000000¢"0
10-0000000000F "0
10-4000000000S°0-
10-0000000000%° 0~
10-30000000002° 0~
10-0000000000% "0~
10-000000000057 0~
10-0000000000L " 0-
10-00000000009°0-
10-0000000000% "0~
10-3000000000€°0
10-00000000008°0

€0+00000000081°0
€0+d00000000LT"0
€0+0000000009T°0
£0+d000000006T°0
€0+000000000bT°0

103 = ¢

¢0+d000000000T°0
10+30000000008°0
10+00000000009°0
10+d000000000F "0
10+Q00000000PE°0
10+Q000000000¢°0
10+d0000000SET"0
10+000000000CT°0
00+d0000000006°0
00+d000000000L°0

01

YoeW = §

(
(¢
(¢
(1
(1
(1
(T
(1
(1
(1
(1
(1
(1

- N ™M N

—

HANMS N OSSO ®O

‘€ )D
‘T o
‘T )2
‘01D
‘6 1D
‘g 1D
‘L )d
‘9 )D
‘s 1D
‘b )D
‘€ )D
‘2o
‘11D

quaucdwos JUBTOTIJL0D I0J san(ea uoTioung

K13ug
Kijug
Kijug
Kiajuz
K1qug

24 91qeTIEA D[qE] I0J S1TIJUS JO IdqunN
Z# d1qeriea 3(qel

K1qug
K13ug3
K13jug
A1qug
K1jug
A13ugz
A1qug
Ki3ug
Kijug
Kiqug

14 @TqeTIeA BTqE] 103 S8TIJUd jJO IaqunN
T# @T9eTIRA BTqPL
$9TqeTII®A 2Tqe] JO IaqunN

UOT]IBATISP jJO uWﬁuo

14 jusuodwod UBTOTIIS0D 103 BIPQ <xxxwxxxxxs

00+@0000000000°0
00+00000000000°0C
00+00000000000°0
00+d0000000000°0
00+d0000000000°0
00+00000000000°0
00+00000000000°0
00+d0000000000°0
00+00000000000°0
00+00000000000°0
00+00000000022°0
00+d0000000022°0
00+a000000002C°0
00+00000000022°0
00+00000000002°0
00+Q00000000¢2°0
00+d000000002C°0
00+d00000000¢2°0
00+30000000002°0
00+00000000081°0
00+0000000000% "0
00+d000000000F "0
00+3000000000%°0
00+0000000000% "0
00+0000000000%°0
00+d00000000k%"0
00+0000000000%°0
00+d000000000%°0
00+000000000vE"0
00+Q000000002€E°0
00+0d0000000005°0
00+000000000¢S°0
00+00000000025°0
00+a0000000095°0
00+00000000085°0
00+00000000009°0
00+00000000096°0
00+00000000096°0

‘01) 2

)0
)2
o)
)2
]
)2
)0
]
e}

‘0T)D

)0
)2
I}
)0
| Je}
)2
B}
| Je]
| Jo]

‘0T)D

e}
o]
)2
B}
)0
)2
o]
)2
o]

‘0T)D

‘s
‘L
‘9
‘S
‘v
‘t

)0
}2
| Jo]
o]
)0
)2
o)

sjusuodwoo USTDTIFS0D JO IBQUNN

XEXANSXERANAXNAXENANENERRANKNERN
xx w3 LNIIDIAJI0D »y
AEAXKXRFEXXRRENR LR RN LR RN ERARL RN

gy :ebed
€661 Anr :eleq

92/-H7 :8pod Wwewndog
"ev/Hvany :uoneziuebio



00+00000000009° 0~ (s ‘p )D

00+00000000009 "0~ (g ‘€10 z saTqeriea a[qel JO IaqunN
00+@0000000009 "0~ (¢ ‘2D
00+30000000009 "0~ (¢ ‘12 wiou Awo = 9 14 @1qeTIean uoTieATILa(
00+d000000000b "0~ (p ‘52
00+Q0000000009 "0~ (¢ ‘b )2 1 Uo13eATISpP JO I3pPI0
00+00000000009°0- v ‘€ )0 ,
00+d0000000009° 0~ (b ‘¢ )2 Z# Jjusuodwoo JUBTOTJIII0D 10T BIB(Q Caxxwxxyxxx
00+Q0000000009 "0~ (v ‘11D
00+d000000000% "0- (€ ‘61D 10-d000000000¢C° 0~ (¢ ‘0T)D
00+00000000008°0- (€ v 1D 10-0000000000V "0- (G ‘6 )D
00+d0000000009°0- (€ ‘€ )D 00+d0000000000°0 (6 ‘'8 )2
00+d0000000009°0- (€ ‘212 00+30000000000°0 (6 ‘Lt )2
00+3d0000000009 "0~ (¢ ‘'1T)2 00+00000000000°0 (G ‘9 )D
00+d000000000% "0~ (z ‘6 ) 00+30000000000°0 (S ‘6 )D
10+G0000000091°0- (Z ‘v )2 : 10-A000000000T°0 (¢ ‘v )0
00+d0000000009 0~ (Z ‘€ )2 10-Q000000000T1°0 (6 ‘€ )2
00+d0000000009°0- (z ‘2 )2 10-0000000000T°0 (¢ ‘2 )D
00+0d0000000009°0- (z ‘112 10-d000000000T° 0 (6 ‘1)D
00+Q000000000% "0~- (1 ‘61D 20-d0000000005°0 (y ‘01)D
00+3000000000V "0~ (T ‘v )2 004Q0000000000°0 (v ‘6 )O
00+Q000000000% "0~ (1 ‘¢ )D 20-d000000000S5°0 (v ‘8 )2
0044000000000V "0~ (1 ‘2 )2 00+A@0000000000°0 (y ‘¢ )D
00+0000000000F " 0— (1 ‘T 1D . 00+d0000000000°0 (v ‘91D
00+00000000000°0 (v ‘G )D
jquauodwod USTDOTIIS0D I0F sInTea uorldung 10-d0000000002°0 (p ‘'t 1D
10-d000000000T"°0 (v ‘€ )D
€0+30000000081°0 ¢ 4Aaaug ' 10-d0000000002°0 (b ‘21D
€0+d00000000LT"0 p AK13ugz 10-d000000000%°0 (¢ ‘T)D
£0+0000000009T°0 ¢ 4Kajug 10-3000000000T°0~ (€ ‘0oT)D
£€0+d000000005T°0 ¢ Aiajug 10-d000000000T° 0~ (€ ‘6 )D
£0+d00000000FT"0 1 Aajug 00+d0000000000°0 (¢ ‘8 )2
20-a000000000S°0 (€ ‘L )2
S Z# °T9qeTIea @[qel JOJ S$3TIJUd JO IdqunN 00+d0000000000°0C (¢ ‘9 )2
00+00000000000°0 (€ '6 )2
303 = ¢ Z# 219qetIea aTqel 10-4000000000C° 0 (€ ‘% )2
10-3000000000T° 0 (€ ‘€ )2
20+d0000000201°0 ¢ A1qugz 10-00000000002°0 (¢ ‘2 )0
10+3d0000000009°0 v Ax3ug , T10-A000000000Z°0 (€ ‘T2
10+40000000000% "0 g Aa3jugz T10-d000000000€E "0~ (zZ ‘0o0)D
10+0000000000€°0 ¢z Ai1juz 10-0000000000C° 0~ (Z ‘6 )2
10+Q000000006Z°0 1 Aajuz 00+d0000000000°0 (¢ ‘g8 1D
. 10-4000000000¢2 "0~ (Z ‘'t )2
S 14 @Tqeriea a[qel I10j S8TIJUd JO IaqunN 10-0000000000C° 0~ (Z ‘9 )2
10-d0000000002 "0~ (¢ 's )2
UoeW = § 14 @19eTaen 3Tqe] 00+00000000000°0 (Z ‘¢ )2
v ebed 9¢/-H1 ‘epod ewndod

£664 Anr tereg Hav/danl ;uoneziuebio



T0-020E1E9bvEY "0
T0-Q0008LLS9GT 0
T0-066CZBLLEET O

€0+0J0000€000TT°0
€0-00000EBETL8 0~
£0+300006669S1°0

Z20+000000955¢S°0
10+03000000€9S6 "0~
G0+00000000011.°0

10+0000008TTEY "0
€0+00000656€12°0
€0+000009€102C°0

Testaayds = |

EXARXXNRERREXNREENNXANERKXXXXN RS
xx SNOILWVYId0 NOISTINdOHd «x=»

AXKRRRERRRRRNERXRRNN L LR RXNARNY

sabueyd> uoyiIRINBIIUOD JO Iaqunp

XXERRRXINENEEXEFANEEXRRLXANERE
*x SAONYHD NOILIVHNOIANOD x»
EXENNXNRR A AR RN RN LA XX R XN ANY

(s/bap) z ebawo aie1 mek aenbuy
(s/bop) A ebawo ajex yo3td aeinbuy
(s/bap) x ebawo ajex (101 Ie[nbuy
sa3el IeTnDbUY <xxxxxrxxxx

(bap) ewbis afbue jueg

(bap) e3aq drissapls jo ar1buy

(boap) eydie yoejie jo aibuy
IPNATAIIV <xxxxxxvxxn

(bap) 1Yo butpESH

(bap) euweb arbue yaed-ybri1a
(s/u) A K3T0072A dar3e(dY
KAJTOOTOA <xxxxxxxsvxx

(bap) earap epnitTiE]

(bap) ne3 aspnatbuo]

(ux) y aybreH

UOTATSOd <sxxxaxxxxyxx

Ay1ooT@a pue uor3tsod TeTITUT JO SdToYd
ANNENERENXNRN AR NERANXRELXREEXRN

xx JIVLS TYILINI xx
RANRERENEXNNRNENN SRR VXN RERXANXAKRY

pautjep [apou putm oN

FRNNNERRRAERFNAENANRNNXXRRRRAAR

xx TAAOW ONIM xx
EERNNNRAARNRNN R A RN RN B AR RN AN RNN

00+00000000000°0 uotaefasp Kaysusp jo abejuaoiag

XXRRXAXRNEREXENNRFRBRRXREXRNKEN
‘% SNOILVENNLYAd xx
AXNERRRNRERXANRANNRR N RN RANNNY

(qe3) 98vdID Tepow aiaydsowiy

[}
™

pIaT3 TeIjUa) = [ {opow [PUOTIEITARID

yliey Apoq Tea3U3)

]
—

AXXAARNAANEENRREX RN RN ALY R AN
¥ . LNJWNOYIANY xx
EAXANNERAAPARXRRRNNXE L RRL A RN RN

N juasaid authus uang-3TqI03Qg
FANRRNREMEARNENNEX RN RAXRENRNRS

x W31SAS NOISTINdO¥d ax

AXRREARNNXFARRNENNX AR AR ERXNNEY

N pajoa{as sauea utds
O# UOTIRINDBTIUOD <Cxxxxsnxwyny
AERBRNARN AR KRN XA AANAN LR ENER K

xx  SINIWOW/SIDHOI TUNYILXI x»

EEAREEEXERRAXRERERNXERRNRERRENY

0 swajysAs 23nyoeried jo Iaqunp

AXRRENERANRERNXNENXRANXANERNENY
*x SWILSAS JLNHOVHEVd xx

EEERRANXERRSNEXX AR RN RRN ALY

00+0000000000% " 0- (¢ ‘5 )D

Gy :ebed
€661 AInr :eleq

92/-41 :8poo ewnooq
He2v/4vanl suoneziuebio



Z 2z =z 2

€0+000000006LC°0
X

Z¢0-01S6LLS62LS™0
b0-0aT1S6LLG6CLS™O0
Z0-Q1S6LLS6TLS"0
00+30000000001°0
¢0-aTS6LLS62LS™0
20-QTS6LLSECLS O

00+30000000001°0

10+0000000000T°0
10+0000000000C°0
10+3000000000T°0

ayg (8L "S'A = ¢

sinssaid otweudp Aq doas

Iaqunu yosew Aq dois

A31ooT12n Aq dois

qybtay Kq doas

oas ut awtl yby13 pasdeld

swty 3yb113 Aq doas
NEXXXEXNNRNENENAARNXN AR RARRREXENXNEY

xx ¥IY3LIYD dOods xx
REREXERANRNARAXERNRXRRRERNL RN
(bap) @pnaTile 103 IDUERIBIOL
(s/bap) saiea aeynbue 103 aduUBIBOL
(bop) sa1bue uoritsod Jo03j sduEIBTOL
{w) uotTatsod 103 9dURIDTO]

(bap) Hutpeay 103] 2OURISTOL

(bap) at1bue yaedayby1y 103 BdOUBIBTOL
(s/w) K3TD0T@A I10] @OURISTO]
XEXXERNXMEAXEARNRRNNXXRMEXNXRXREXE

»x SIONYYIT0L xx
EEXXXEXAXENLNNERNRNER AR A XX ARDPY

(s) @3ex butr(T1j eaiep 301d a8yl

(s) @31ex BbutTtj e3ep Yoo[yd>inb ayl
(s) @z1s dais uoTrieIbajur wWnWIXeWw ayj
poylau uorieibajujg
EEREFRENRSRANXEFMERXR AR ENNELNEY

»a NOIIVYOALNI x»
XEXAXXAKNERNERRRSXRAXRXX RN NREN

pe10a(8s SIANBOURW UINQ-3TqI03Q

gy :ebed
€661 Anr :eieQ

92/-H1 :9p00 WewnooQ
yev/dvanl :uoneziuebio



Report LR-726 Appendix B - Example of quicklook data

July 1993 Ir. E. Mooij

TU Delft

Delft Uiersity of Technology

Faculty of Aerospace Engineering




Date: July 1993

Organization: TUD/LR/A2R
Page: -

Document code: LR-726

This page has been intentionally left blank



¢0-30€800v°0

00+3000000°0 00+3000000°0 0°900TT
(bap) 17e Tyo ‘(Bop) Ite euweb ‘(s/w) ITE A

2586°2S G69VE"6- 0790011
(bap) butpesay ‘oybue yied ‘(s/w) AjydoTan mold

906°21¢ SOTbS b 6SC° V12
(wy) 3ybiey ‘(Bap) apniyie] ‘epnitbuol D13I3P08D

00000°¢F

(0®s) BWT) UOTIETNWTS

00+3000000°0 00+3000000°0
(by) ssew pappe ‘(N) beip-aeg
¥88°G0T~ Sh8TT 1 bG86 L9~
(bsp) mek ‘(bap) yo31d ‘(bop) 107
S1°800T1 60-39T6€0T°0 p0-dZ€E0E"0
() -dwal ‘(Exxw/BY) -sudq ‘(Zxxw/N) -ssa1d ruiy
€ELS0TTO Z6€9° LY 20-dr€0629°0
sproudkay ‘yoeW ‘(ZxxW/N) "ssaxd oTweudq
G0-3L6690L°0~- ¢0-d8EOLTIL O 90-3889L5h "0~
(uy) swex3y Apoq UT s3uswow OTWeuAporay
§0-3662%96°0- 9620170 T0-3596H2E°0
(sweaj-y) (N) 903103 apls pue beag ‘313711
G0-366C¥96 "0~ 9620170 10-4596v2€°0
{1tea) (N} 20103 apys pue beig ‘3311
¢00°LST 6667601
(bop) ate 103 eydiy ‘eo1bue xued
¢0-d0€L091°0 £0-3e0S%CL 0 200°LST
(ces/bap) jop easg ‘10p euydiv ‘(bap) e3lag ‘eydiy
T0-3LBELEY O 10-3%898G61°0 TO-3LLLEET"O
(oas/bap) AaT1d0[9A 1e[nbue 3TOTYSA
00+3000000°0 00+3000000°0 0°€001T
(bop) 1T1e Ty ‘(Bop) I1e Euweb ’(s/w) ITE A
poLS°es €0SSh 6~ 0°€00TT
(bop) Butpeay ‘efbue yjed ‘(ss/u) A3ToO0TSA MOTJ
T06°91¢ 8€9¢Ch b 601°v1¢C
(wuy) 3ybtay ‘(bap) spnatiey ‘spnitbuo] 25139pP03
00000°2

(09S) Bwll UOTIBTNWIS

00+3000000°0 00+3000000°0
(bY) ssew pappe ‘(N) beip-iegd

868°G0T- Zh602°1 , esh6 L9
(bap) mek ‘(bap) yo31d ‘(bap) 1702

90°€201 0T1-d6Z2€16°0 P0-4d7¢9692°0

(M) -dwal ‘(gxxw/bY) -suUBQ ‘(Zxxw/N) -ssa1d -uiy

T0-3ar1S626°0 801G LT ¢0-31T0626S°0
spTouday ‘yYoeW ‘(ZxxW/N) "ssaid oTweukq

90-dpsss0L "0 20-3y900€9°0 LO-3SE0LSY "0
(uN) swexj Apoq uT s3juswow dTweulpolay
90-3618296°0 T0-36T€V06°0 T0-3L60S8Z°0
(swe13-y) (N) 92103 apIS pue bexq ‘3IIT1
90-4618296°0 10-361EK06°0 10-9.60S8Z°0
(11ep) (N) 92303 °pTs pue beig ‘3371
666°9ST €00°0TT
(bap) ate 303 eydiy ‘aibue jueg
00+3000000°0C 00+4000000°0 £0-dEBETZB 0~ 666961
(oas/bap) 1jop eisg ‘3jop eydiy ‘(bep) eieg ‘eydiy
TO-3E9bbEV O 10-9d8L6961°0 T0-d8LLEET O
(oas/bap) A3tooiaa aefnbue S[DTY3A
00+3000000°0 00+d000000°0 0°000TI1 _
(Bap) 1te 1yo ‘(bap) i1Te ewweb ‘(s/uw) ITE A
0965729 00E9G "6~ 0°000T11
(bap) butpesy ‘srbue yjed ‘(s/uw) A31d07aA MOTJ
9£1°0¢¢ 08T1E "V 6G6°€1C

(ux) 3ybtay ‘(bop) epnirjel ‘epnitbuoy 2T13IL9PO3Y
00+3000000°0
(02s) 8wll uoIjPTOWES

AR ANNE NN SN A AN A RN RN AN NN AR AR NN R XA XN RN A XA XXX A RN AN

I Ty R S R R R R

LY xx
xx e
xx ' ¥Yiva 0O THXOIND xx
xx xx
% %

P I i R Ry O R S S R

P Il T e R RS SR R R R Y

‘uonejnwis ayl Buunp usaios ayl 0} usRum Os[e SI elep
soopoinb ayy jo Aluofew ay] “(siay papnjoul Jou) ||dM SB UsliMm SI Jaserep
induy pasn ay) ‘o Siyl 01 "usAlb si ‘apyerep soopoinb ayl ul seadde Aauy
se ‘ejep yoopinb ay) jo ajdwexa ue ‘sabed omj Buimojjoy 8yl pue siyl uQ

Lg :ebed
£661 Anr teleg

92/-41 :8pod JuswinooQ
Hav/Hvand :uoneziuebio



T0-3SEOVEL "0 T0-3L800LT 0 TO-2TILEET O

(oas/bap) A3TooiaA 1e[nbue BaTDTY3A

00+3000000°0 00+3000000°0 8°F10T1
(bap) 11e 1Yo ‘(Bbep) aTe ewweb ‘(s/w) ITe A

r1€9°¢S 802Z0°6- 8°F10T1T
(bop) Buipeay ‘sTbue yied ‘(s/w) A3Io0T2A MOT3

19¢€°¢0¢ 09688° ¥ [A YR A ¥4
(uy) 3ybyey ‘(bep) apniyTiel ‘spnitbuo] 25732p03n

0000°0T

(o@s) Bwy3 UOTIETOWIS

00+d000000°0 00+3000000°0
(bx) ssew pappe ‘(N) beap-ieg

287601~ YLESEE™O €901°89-
(bap) mek ’(bop) yo31d ‘(bap). 102

9y0° VL6 60-30661ST°0 v0-30vZLZY O
(M) -dwal ‘(Exxw/BY) -sudq ‘(ZyswW/N) ‘sS31d -uly
6066510 6Tb6°LT 20-3L26T26°0

sproukay ‘YoeW ‘(ZxxW/N) "ssaid ortweuiq
10-32L8p0T°0 S0-390vv8C°0-
(wN) owexj Apoq uy sajuswow odjweulporay
P0-30Lv66S 70~ 0L80ST°0 10-3TSESLY "0
(swea3-y¥) (N) ®o103 apTs pue beig ‘3311l
Y0-30L¥66S°0- 0L80ST°0 TO0-3TGSESLY O
(1TeA) (N) ®d3103 9pTS pue beig ‘3II11
b10°LSt L86°601
(bap) 1t1e 303 eydiy ‘arbue xued
20-3v06vEC"0 T0-366¥90E°0 p10°LSt
(oas/bap) jo0p e3ag ‘3op eydiy ‘(bsp) eisg ‘eydiy
T0-3CEThEL 'O T0-3L0L99T°0 TO-d89LEET 0
(oes/bap) Ka1oo(aa 1e[nbue STOTYIA

p0-3T19T6€b "0~

20-3EL6C28E°0

00+3000000°0 00+3000000°0 6 11011
(bap) 1Te Tyo ‘(Hap) a1e ewweb ‘(s/w) ITE A

Le19°¢S 8v0ET 6~ 6°TI0TT
(bap) butpeay ‘aibue yjed ’(s/u) A3TO00T2aA MOTJ

9€8°G50¢ 990LL" Y 196°p1C
(wx) 23ybray ‘(bep) apnitaey ‘spnitbuofl oT138p03n

00000°8

(09§) SWT3 UOCTILTOWIS

00+3000000°0 00+3000000°0
) (bY) ssew pappe ‘(N) beap-ieg

9687601~ LOb9E6 O 659089~
(bap) mek ‘(Bbap) yo31d ‘(bap) TT07

20-3L2688E°0

C0-3LLBVBE"D

862°986 650-38KLEET 0 p0-AT6908E "0
() -dwal ‘(gysw/bY) ‘sUBQ ‘(ZuxW/N) -ss21d -waiy
_OLZEET"O vZE8 LT Z0-3€640T8°0

spToukay ‘yUoeW ‘(ZxsW/N) "ssaid ojueulqg
¢0-3E€6226°0 S0-3h6ELBT 0~
(uN) sweijl Apoq uUT sjuswow DJweulApoIay
p0-3abZ6v6€°0- ¢89ZET"0 10-30218TV "0
(swea3y-¥) (N) ®d103 apTs pue beag ‘33T
b0-d¥Z6V6E°0- ¢89CET°0 10-302T81V 70
(1Tep) (N) 92303 apTs pue beig ‘3311
0T0°LST _ 166°60T
(bep) 1T1e 107 eydy ‘a71bue yueg
Z0-3620L0C°0 10-39096¢22°0 0T0°LST
(oas/bap) 10p eiag ‘3op eydiy ‘(bap) eisg ‘eydiv
10-3€22VvEP "0 T0-380LE9T 0 T0-3ELLEET O
(o9s/bap) A3lT1o0T9Aa Je[nbue 3TDTY3A

p0-dThE68BZ 0~

00+3000000°0 00+3000000°0 _ 6°8001T _
(bap) 1t1e Tyo ‘(bap) i1Te ewweb ‘(s/w) ITE A
"€009°¢S LLBET 6~ 6°800T1
(bap) butpeay ‘arbue yied ‘(s/u) A3TD0T3A MOTJ
16€°602 18869 "% {0 2 A4
(wy) 3ybiay ‘(bap) spnatiey ‘spnitbuol o139poe
0000079

(o2s) awT3 uorleTOWIS

00+3000000°0 00+3000000°0
(by) ssew pappe ‘(N) beap-aeg

0L8 G0T- bvtzo 1 96Z0°89-
(bap) meA ‘(bap) yo31d ‘(bap) 1102

118°566 60-3TY08TT 0 p0-3v2Z6EE" 0
(1) -dwal ‘(gxxw/BY) -suag ‘(Zxxw/N) -ssa1d -uway
bLT2Z1°0 LLbL Ll Z0-3LZ6VTL 0

spioufkay ‘yoeW ‘(ZxxW/N)ssaad otweuig
¢0-d686hT1870 S0-368060T1° 0~
(uN) swexj Apoq ul sjusuwow DIweuApoiay
¥0-389862C°0- 0€oLTIT 0 10-34S889¢€°0
(swea3j-y) (N) ©@0103J opls pue Heig ‘3IJT1
b0-389862C°0- 0EOLTIT O 10-3pS889€°0
(1TeA) (N) @2303 ¥p1S pue beig ‘3311
900°LST G566 "601
(bap) 1t1e 303 eydly ‘s1bue yueg
Z0-d0EYZBI"0 T0-3€ZSTST°0 900°LST
(o9s/bap) 10p e33g ‘30P eydiy ‘(bap) eaisg ‘eydiy
T0-3JLOEVEY O 10-d8¥0191°0 TO-39LLEET 0
(oas/bap) L31o0Taa zeinbue BTOTY3A

v0-36Z¥89170~

2g :ebed
£661 AInr :e1eQ

92/-47 :8p0d Wewnaog
"ev/dvany :uoneziuebio



Z0-31588G€°0 Z0-d90€68E°0 10~30L0209°0 6€0°LST

) Aomm\mmvv qop eaag ‘jop eydiy ‘(bap) eieg ‘eudiy

TO-3YBIEEDL "0 10-3¥TTE8T70 T0-3bCLEET O
(oas/bop) A3TooTlaA 1eTnbue [DTYaA

00+3d000000°0 00+3000000°0 Z°eC01T
(bop) 1Te Tyo ‘(bep) iITe ewweb ‘(s/w) ITE A

L089°29 62969°8- 2°€C011
(bap) butpeay ‘arbue yaed ‘(s/w) K3Tdo073A MOTJ

6LT7C61 680€C°S 991°61¢
(wy) aybray ‘(bep)} opniTiey ‘spnitbucy o5138p0oad

0000791

(99S) BWT3 UOTIBTNUTS

00+3000000°0 00+3000000°0
(bY) ssew pappe ‘(N) beip-1eg

208°501- pSSTLS O : 082Z " 89-
(bap) mek (bap) ys31d ‘(Bap) 1702

L89°LEG 60-36EVECZ 0 y0-3b€9¥09°0
(i) -dwsl ‘(Exsw/BY) °SUBQ ‘(ZxxW/N) ~ssOId "uwy
. 1€1062°0 68L2°8T T0-3€89GET"0

spToufkay ‘yoeW ‘(ZwxsW/N) "ssaxd otueudg
T0-49€0VST1°0 G0-d896€EZL "0~

(uN) sweij Apoq Ut s3jusuwow dtweudpolray

£0-3¥692S1°0- 00zzee'o 10-3909669°0
(swe13-¥) (N) ®2103 9pTS pue beig ‘3IIT1

€0-3¥692S1°0- 00zzee" 0 10-3909669°0
(1tep) (N) 90103 apis pue beig ‘33711

Ze0° LSt 9.6°601
(bap) 1t1e 301 eydiy ‘sybue yueg

¢0-4dZ8OEVE"Q 10-3¥6662¢5°0 2€0°LST
(o9s/bap) 10p e3ag ‘3op euydiy ‘(bap) eaad reyd 1y

10-3ZT8EEV 0 10-396228LT°0 T0-30VLEET O
(o9s/bap) KiTooTan aelnbue BTDTY3A

£€0-3228T1T1°0-

¢0-3656%9€°0

00+3000000°0 00+3000000°0 b 02011 _
(bap) I1e 1Yo ‘(bap) 170 PuUMED ‘(S/W) ITE A

0¥99°¢S 66Y08 8- b 0¢01l
(bap) butpeay ‘arbue yaed ‘(s/w) A3rd078A MOTJ

€EG G6T TLSIT'S P10°ST¢
(wy) 3ybiay ‘(bap) spniatie] ‘epniitbucy 213I9pOa9

0000°%T

(D9s) awT3 uUoTILTOWIS

00+9000000°0 00+3000000°0
(bY) ssew poppe ‘(N) beap-ied

20-3%001LE"O

20-3€00LLE"D

518°50T- 9THE99 0 bL8T 89~
(bap) mek ‘(bap) yo3i1d ‘(bap) TT03

bbb 86 60-3L89961°0 p0-38HEBES O
(4) -dwal ‘(gxxu/BY) -suaq ‘(Zxxw/N) -ssa1d -wiy
0L860Z°0 L9LT 81 10-3LLE6TT O

spioukay ‘yseW ‘(ZxxW/N) -ssa1d oTweuiq

T0-d8¥9GET"0 G0-32168¥S°0-
(wN) sweij Apoq uT sjuswow DTWeEUApOlIay

pO-3€VLLEB O

€0-dSPLSTT O~ SLYS6T O T0-3€29619°0
(sweij-y¥) (N) @2103 @pTs pue Heig ‘3371
€0-dShLSTT 0~ SLY¥S6T 0 T0-9€Z9ST19°0
(11ep) (N) 92103 op1s pue beig ‘3311
G¢0 LSt _ 6L6°60T
(bap) 11e 303 eydiv ‘sibue >uegq
¢0-38YECOE"O 10-d6699Sh°0 SC0°LST

(oas/bap) 10p eilag ‘jop eydiv ‘(bap) elad ‘eydty
10-36C6EEV O 10-3v06ELT O T0-3ZGLEET O
(oes/bap) K31doTan 1eTnbue a(dTYaA

00+d000000°0 00+3000000°0 ) 9°LTOTY _
(bap) a1e TyS ‘(HOP) 11e euweb ‘(s/w) ITEe A
SLb9°CS 6GE16° 8- 9°LTOTT
(bop) butperey ‘aTbue yjzed ‘(s/w) A3To0[3A MOTJ
126°861 19000°¢S €98°b1¢
(wy) 3ybtay ‘(bap) spnitaey ‘@pnithbuo] 2>138p0aY
0000°CT

(o8s) BwWTr) uoTlIRTNUWIS

00+d000000°C 00+3000000°0
(by) ssew pappe ‘(N) beap-ieg

828 601~ LI9EPSLO 89v1°89-
(bap) mek ‘(bap) yo3vd ‘(bap) 1101

625°666 60-3p9TELT O v0-320G6LL "0
(d) -dual ‘(gxsw/bY) -suaq ‘(Zsxw/N) °-ssaad w3y
6ZhEBT 0 £€L0°8T 10-35Y0S0T°0

sproukay ‘yoep ‘(ZaxW/N) -ss23d ojweuiqg

T0-36S¥6T1T1°0 G0-3SshCvob "0~
(uN) swe1l Apoq ul sjuswow OIwRUuApoOIaY

v0-365¢¥29 70~

v0-322¢CS8° 0~ Z661LT O 10-306L10G°0
(sweij-y) (N) 8d103 2pls pue beig ‘3311

b0-322¢CS8°0- Z661LT0 T0-306L1TPS°0
(11ep) (N) @o103 opls pue bexg ‘3311

610°LST £€86°60T
(bap) 11e 103 eydiv ‘srbue ueg

20-388%99¢2°0 10-386128E "0 6T0°LST

(oas/bap) jop eieg ‘10p eydiy ‘(bap) e3eg ‘eydly

cg :ebed
€661 Ainr :ereq

92/-47 :epod WwewnsoQ
Hev/Hvany :uoneziuebio



934464





